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Safety Information

Safety Information
Important Information

Read these instructions carefully, and look at the equipment to become familiar with the
device before trying to install, operate, service, or maintain it. The following special
messages may appear throughout this documentation or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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Safety Information

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction and
operation of electrical equipment and its installation, and has received safety training to
recognize and avoid the hazards involved.
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About the Book

About the Book
Document Scope

This manual contains the XPSMCWIN software description.

The XPSMCWIN software allows you to set up, configure, start, and perform diagnostics on
the XPSMC Safety Controller using a PC.

The software is used for the installation, documentation and diagnostics of your application.

Validity Note
The technical characteristics of the devices described in the present document also appear
online. To access the information online, go to the Schneider Electric home page www.se.
com/ww/en/download/.

The characteristics that are described in the present document should be the same as those
characteristics that appear online. In line with our policy of constant improvement, we may
revise content over time to improve clarity and accuracy. If you see a difference between the
document and online information, use the online information as your reference.

Six versions of the XPSMC Safety Controller are available:

Type Characteristics

XPSMC16Z 8 control outputs and 16 safety-related inputs

6 safety-related transistor outputs

2 x 2 safety-related relay outputs

Modbus (RTU) communication and configuration port

XPSMC16ZP 8 control outputs and 16 safety-related inputs

6 safety-related transistor outputs

2 x 2 safety-related relay outputs

Modbus (RTU) communication and configuration port

Profibus DP communication port
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About the Book

Type Characteristics

XPSMC16ZC 8 control outputs and 16 safety-related inputs

6 safety-related transistor outputs

2 x 2 safety-related relay outputs

Modbus (RTU) communication and configuration port

CANopen communication port

XPSMC32Z 8 control outputs and 32 safety-related inputs

6 safety-related transistor outputs

2 x 2 safety-related relay outputs

Modbus (RTU) communication and configuration port

XPSMC32ZP 8 control outputs and 32 safety-related inputs

6 safety-related transistor outputs

2 x 2 safety-related relay outputs

Modbus (RTU) communication and configuration port

Profibus DP communication port

XPSMC32ZC 8 control outputs and 32 safety-related inputs

6 safety-related transistor outputs

2 x 2 safety-related relay outputs

Modbus (RTU) communication and configuration port

CANopen communication port

The types XPSMC16X and XPSMC32X are obsolete. Nevertheless they can be handled by
the XPSMCWIN software described in this document.

This documentation is valid for XPSMCWIN under Microsoft Windows 2000 / XP / Vista / 7.

Related Documents
Title of Documentation Reference Number

XPSMC Safety Controller - Hardware Manual 33003275
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Safety Information on XPSMC Safety Controller

Safety Information on XPSMC Safety
Controller
Safety-related Information

WARNING
UNINTENDED EQUIPMENT OPERATION
• You must carry out a risk assessment in accordance with ISO 12100.
• Validate the entire system/machine in accordance with the required performance level

and risk assessment.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Observe the required test cycles according to your application.

User Responsibilities
The information provided in this documentation contains general descriptions and/or
technical characteristics of the performance of the products contained herein. This
documentation is not intended as a substitute for and is not to be used for determining
suitability or reliability of these products for specific user applications. It is the duty of any
such user, machine builder, or system integrator to perform the appropriate and complete
risk analysis, evaluation, and testing of the products with respect to the relevant specific
application or use thereof.

Neither Schneider Electric nor any of its affiliates or subsidiaries shall be responsible or
liable for misuse of the information contained herein. If you have any suggestions for
improvements or amendments or have found discrepancies in this publication, notify
Schneider Electric. All pertinent safety regulations must be observed when installing and
using this product. For reasons of safety and to help ensure compliance with documented
system data, only the manufacturer should perform repairs to components.
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System Requirements and Software Installation

System Requirements and Software
Installation
Overview

This chapter contains the system requirements for the software and hardware.

System Requirements

Hardware
The following is required to use the configuration software with the safety controller:

• an XPSMC Safety Controller
• a configuration cable
◦ TCSMCNAM3M002P (for USB port) or
◦ TSXCUSB485 + 490NTW00002 or equivalent straight (1:1) RJ45 cable cat. 5D or

better (for USB port) or
◦ TSXPCX1031 + XPSMCCPC (for Serial RS232 port)
for connecting the XPSMC Safety Controller to the PC

• a PC with the following minimum capabilities:
◦ Pentium® processor, or equivalent
◦ mouse or an equivalent device
◦ RS232 serial port with a 9-pin subD connector or USB-Port
◦ at least 20 MB free hard disk space

• display: 1024 x 768, 256 colors

Connection between the PC and the XPSMC Safety
Controller

To set up or perform diagnostics on the XPSMC Safety Controller with the XPSMCWIN
software, you can connect:
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System Requirements and Software Installation

• the USB port of the PC and the TER terminal of the controller by use of the
TCSMCNAM3M002P cable

• the TSXCUSB485 cable to a USB port of your PC and to the TER connector of the
XPSMC Safety Controller with a straight (1:1) RJ45 cable cat. 5D or better (e.g.
490NTW00002).

• a serial port of your PC to the TER connector of the XPSMC Safety Controller with the
TSXPCX1031 serial interface cable and the XPSMCCPC adaptor

Software
The following are system requirements for the XPSMCWIN software:

• Operating system: Microsoft Windows 2000 / XP / Vista / 7

Installing the USB Driver for the Configuration Cable
For the USB configuration cables a driver is required. The USB drivers are included on the
XPSMCWIN installation.

The following table describes steps to install them:

Step Action

1 Change the directory to /Drivers for USB Cable.

2 Run the file Communication_Drivers_Pack_*.exe.

The asterisk (*) replaces a version indication.

3 Insert the cable.

4 In the New Hardware dialog box, select Look for an adequate driver.

5 Select Other sources.

6 Select the location of the driver on the hard disk.

Result: The driver will be installed.

7 Verify at the Windows Device Manager which virtual COM port was assigned for the cable.
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System Requirements and Software Installation

Installation

Installation Procedure
To install the XPSMCWIN software, proceed as follows:

Step Action

1 Download XPSMCWIN software from www.se.com.

2 Double-click the Setup executable file to start the installation.

3 Follow the procedure on the screen.
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XPSMCWIN User Interface

XPSMCWIN User Interface
Overview

This chapter contains the description of the software user interface.

Window Types

Introduction
Typical XPSMCWIN user interface window

The items 1 to 5 have the following meanings:
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XPSMCWIN User Interface

Item Meaning

1 Menu bar

2 Tool bar

3 Device library window

4 Configuration window

5 Status bar

Device Library Window
This window contains the eight possible types of controllers (XPSMC16Z, XPSMC16ZC,
XPSMC16ZP, XPSMC16X, XPSMC32Z, XPSMC32ZC, XPSMC32ZP, and XPSMC32X) and
the library of the available devices.

A device is copied from this library into the Configuration window by pressing and holding
down the left mouse button and simultaneously dragging the mouse (drag-and-drop).

Configuration Window
The Configuration window is the working window in XPSMCWIN. The configuration is
defined and modified in this window.

The devices are configured by the following procedure.

If a device is moved into the Configuration window, the specific property window of the
device appears in which the parameters of this device can be set. For more information on
these parameters, refer to Device Library, page 28.

In the menu Options > Editor you can select whether the Properties window appears
automatically or not. In any case it is possible to access the window by double-clicking the
device or by using the contextual menu (right-clicking the device and selecting Properties).
Not all of the devices have editable properties.

The following commands can also be called by clicking the right mouse button on a device in
the Configuration window:

Command Description

Properties Open the Properties window of the selected device.

Copy Using this command, a device can be copied with the properties assigned to it and
pasted elsewhere in the configuration tree.

Cut Cut the selected device.
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XPSMCWIN User Interface

Command Description

Paste Paste a copied or cut device as a copy or as a new device into the selected location.

(A copy of a device adopts the properties of the original. It is another instance of the
same device. A new device is independent, with no properties set yet).

Delete Delete the selected object.

Delete incl. copies Delete the selected object and its copies.

Mark copies Mark the copies of the selected device.

Unmark copies Clear the markings.

Expand all Expand the entire configuration tree.

Expand controller Expand the selected controller tree (only visible when more than one controller are in
the configuration).

Collapse all Collapse the entire configuration tree. Only the controller will be shown.

Elements of a Window

Menu Bar
The menu bar contains the commands of the XPSMCWIN software as shown in the
structure overview below.

Menu bar for Configuration mode
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Menu bar for Configuration mode (continued)

Menu bar for Diagnostics mode
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Menu Commands

Menu Commands
Overview

This chapter contains the description of the menu commands.

File

New
Click New to create a new configuration. When this command is called, a new window
appears in which the name and the author of this configuration can be indicated. A message
box appears for saving an existing configuration if a configuration is already opened.

To enable opening the Properties dialog box automatically, after you drag and drop a device
onto the Configuration window, select option automatically open properties dialog if a
new device is dropped onto configuration in Editor on the Options menu.

Open
Click Open to open a file selection popup menu. Here you can select an existing
configuration. Additionally a backup file is created in the same directory with .mcb extension.

Save
Click Save to save the configuration.

Save As...
Click Save As... to save the configuration under a new name.
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Menu Commands

Print Tree
Click Print Tree to print the configuration, and choose one of the following options:

Option Meaning

as you see it The configuration tree will be printed as you see it in the configuration
window.

all the nodes expanded The configuration tree will be printed with the nodes expanded.

Exit
Click Exit to quit the XPSMCWIN software. If changes have been made to the configuration,
you will be asked whether you want to save changes before quitting the program.

Edit

Undo
Click Undo to cancel the last action. You can repeat the step up to 10 times in a row.

Redo
Click Redo to restore a cancelled action. You can repeat the step up to 10 times in a row.

Copy
Click Copy to copy the selected item to the clipboard.

Cut
Click Cut to cut the selected device.
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Menu Commands

Paste
Click Paste to paste an item from the clipboard to the selected location, and choose one of
the following options.

Option Meaning

as a copy of the device The device will be copied with the properties of the source device (e.g., the
same input and output) if the same hardware is connected to different inputs
and outputs of the XPSMC Safety Controller.

as a device The device will be copied with its default properties. Alternatively, you can
drag the device to the selected location.

Delete
Click Delete to delete the selected item.

Mode

Configuration
The Configuration mode is the software working mode. In the Configuration mode, a
configuration is created, modified, and sent to or reloaded from XPSMC Safety Controller.
When the program is started, this is the default mode of the software.

Diagnostics
The Diagnostics mode is used exclusively for performing diagnostics on the XPSMC Safety
Controller connected to the PC. The configuration cannot be modified. In the Diagnostic
mode, the software working windows are grey in color.

In this mode, the connected XPSMC Safety Controller operates without being affected.
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Check

Check Configuration
Use this command to verify whether the configuration is correct, before you download it into
the XPSMC Safety Controller.

NOTE: The configuration will be verified for consistency. This neither verifies the
functional safety nor the suitability of the configuration for your application. You must
ensure this and for compliance with all applicable codes and standards.

WARNING
UNINTENDED EQUIPMENT OPERATION
• You must carry out a risk assessment in accordance with ISO 12100.
• Validate the entire system/machine in accordance with the required performance level

and risk assessment.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Controller

Stop Controller
Click Stop Controller to stop the XPSMC Safety Controller. Its safety-related outputs are
de-activated in accordance with their stop category (either immediately or with a delay). The
password must be entered.

Run Controller
Click Run Controller to change the XPSMC Safety Controller to RUN.
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Change Password
Click Change Password to open a window in which you can change the password.
Beforehand, if the controller is in RUN, you will receive a message requesting to put the
controller in STOP.

Download Configuration to Controller
Click Download Configuration to Controller to send the configuration to the selected
controller. Prior to it, if the controller is in RUN, you will receive a message requesting to put
the controller in STOP. Thereafter, you must enter the password.

NOTE: When the configuration is downloaded, the outputs will be deactivated.
NOTE: Please bear in mind that when the configuration is downloaded, the outputs will
be deactivated.

Upload Configuration from Controller
Click Upload Configuration from Controller to load the configuration to the PC and
display the configuration of the connected XPSMC Safety Controller. The XPSMC Safety
Controller is still running at the same time.

Create Validated Copy from Controller
Click Create Validated Copy from Controller to create a file as copy of a validated
configuration.

Those validated copies can be transferred to a controller without the need to be validated
again. This is intended to ease maintenance and configuration of a series of identical
controllers.

Transfer Validated Copy to Controller
Click Transfer Validated Copy to Controller to transfer a validated configuration to a
controller.
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Read Validation
Click Read Validation to provide the date of validation and the name of the person who
performed the validation of the connected XPSMC Safety Controller configuration.

Read Protocol from Controller
Click Read Protocol from Controller to upload the report of the configuration. This allows
you to read, to save on PC, or to print the report. If the controller is in RUN, you will be asked
to stop it.

NOTE: Since the controller is stopped while reading the report, the outputs are
deactivated.

Open Protocol
Click Open Protocol to open a locally stored copy of the report file and to be able to print it.
The file is read-only, and cannot be modified.

Controller Setup (Bus Configuration)
Click Controller Setup (Bus Configuration), and choose one of the following options:

Option Meaning

Modbus (RTU) Opens a window for adjusting the settings required for the operation of all the XPSMC Safety
Controllers (up to 8) of this configuration with a Modbus system. Operation with different
Modbus systems is also possible. By clicking the Download button, the Send the settings
to the controller command is executed. The settings are applicable to all controllers but
need to be downloaded individually.

CANopen If the controller supports CANopen communications, you can set the parameters, like
address and transmission rate.

Profibus DP If the controller supports Profibus communications, you can select the address.

Download Setup to Controller
Click Download Setup to Controller to send the parameters set (for all communication
protocols, i.e., Modbus (RTU), CANopen, Profibus DP) to the selected controller of this
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configuration. The XPSMC Safety Controller must be stopped. The password must be
entered.

NOTE: This command causes only the bus communication parameters to be sent and
not the configuration.

Controller Info
Click Controller Info to display the information about the type of controller, the firmware
version, and the controller status.

The Details button available for some of the controllers provides access to more detailed
information on firmware version and controller state for maintenance purposes.

COM Selection...
Choose COM Selection... to select the COM port (1...16) of the PC to which the XPSMC
Safety Controller is connected. In case one of the USB adapters is used to connect to the
PC, a virtual COM port is established by the USB driver. The number of this port is to be
used then.
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Options

Editor...
Click Editor... to open the Editor Options dialog box. The dialog box allows you to enable/
disable the following options:

• The Properties dialog box automatically shows up immediately for each device that is
dropped to the configuration tree by default.
Alternatively, the Properties dialog box can be opened anytime by using the contextual
menu of the device.

• The creation of validated copies of a configuration is allowed by default.
Alternatively, you can select to create a validated copy during the validation of a
configuration. Even if validated copies are allowed by choosing this option, the validated
copy can be discarded during the validation.

Library
Click Library, and select one of the following options:

Option Meaning

Show all devices The available devices are shown.

Show only devices applicable for Only the applicable devices of specific XPSMC Safety
Controller reference are shown.

Language
Click Language to select the language to be used by the XPSMCWIN software. The
available languages will be shown in the menu.

Help

Contents...
Click Contents... to view an overview of the online help.
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About...
Click About... to view information about the version of the software.

Diagnostics

Start Diagnostics
The transmission of the diagnostics data from the XPSMC Safety Controller to the PC will be
started.

Stop Diagnostics
The transmission of the diagnostics data from the XPSMC Safety Controller to the PC will be
stopped.

Note
Switching into the Diagnostics mode, with menu command Mode > Diagnostics, the menu
bar will be modified like described in the chapter Elements of a Window, page 17.
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Device Library
Overview

This chapter contains the description of the functions and devices of the XPSMC Safety
Controller. They are contained in the Device Library window in the configuration software.
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The image below gives an overview of the devices in the library.
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Controller

Overview
The folder Controller contains the 8 types of controllers: XPSMC16Z, XPSMC16ZC,
XPSMC16ZP, XPSMC16X, XPSMC32Z, XPSMC32ZC, XPSMC32ZP and XPSMC32X.

Creating a Configuration

Introduction
To create a configuration, click File > New.

NOTE: The following examples are for 16 input controllers. The procedure for 32 input
controllers is the same, unless stated otherwise.

Response Time
For the XPSMC16Z, XPSMC16ZC, XPSMC16ZP, XPSMC32Z, XPSMC32ZC, XPSMC32ZP
the response time can be set to 20 ms or to 30 ms.

A longer response time allows more complex configurations.

For controllers with 32 inputs the default response time is 30 ms.

For controllers with 16 inputs the default response time is 20 ms.

For the XPSMC16X and the XPSMC32X the response time is fixed to 20 ms.

Creating a Configuration
To create a configuration, proceed as follows.
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Step Action

1 To create a new configuration, click File > New.

A configuration symbol appears in the Configuration window and a dialog box which contains the Title and the
Author of this configuration opens.

The following figure shows the Configuration dialog box.

NOTE: If this dialog box does not open automatically, this option is not active in the Options > Editor...
menu. The dialog box can be accessed anytime by using the contextual menu of the Configuration symbol
(right-click the symbol and select Properties).

2 The title of the configuration will be part of the configuration saved in the controller.

The other content of the box is for information only.

Fill in the fields and click OK.
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Step Action

3 Choose the controller type you want to configure from the library and drag the related symbol into the
Configuration window.

The Properties dialog box of the controller appears:

NOTE: If this dialog box does not open automatically, right-click the symbol and select Properties.
NOTE: The XPSMC16X and the XPSMC32X controllers support a limited set of devices. Hence when
selected a window appears to ask if you want to hide the unsupported devices from the library.

4 The dialog box allows you to specify the controller type, the communication settings and to select some
controller related options. A detailed description of the parameters is given in the following section Setting Up the
Controller.

Fill in the in the dialog box and click OK.
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Step Action

5 Symbols for the controller and the 8 available outputs are shown in the Configuration window.

You can start to drag devices from the library onto the outputs you want to use to build your configuration.

An alternative way to initialize a new configuration is to start with step 3. When you drag the
desired controller symbol into the empty Configuration window both the configuration and
the controller with the associated outputs appear as do the respective dialog boxes.

Setting Up the Controller
The Controller dialog box allows the following settings:
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Option Description

Name A specific name can be assigned to the controller.

Type tab
In the Type tab you can change the type of controller, select the firmware version of your specific
reference and set the desired response time.

Both the type of controller and the version of the firmware have to match the data on the type label
of the specific device you want to configure. Some features may not be available for all versions.

The Response Time can be set either to 20 ms or 30 ms (except for XPSMC16X and XPSMC32X
fixed response time 20 ms). A longer response time allows the controller to process more complex
configurations, i.e. more devices may be used.

The relative load of the controller is shown in the status bar of the application window. A load of 100
% means no cycle time is left to process additional devices.

Due to the way of processing the response time of Safety Mat devices is generally longer than for
other devices. Depending on the setting it is 30 ms or 45 ms.
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Option Description

Communication
tab In the Communication tab the field bus settings of the controller are shown. Each controller is

equipped with Modbus. As an option there may be CANopen or Profibus communication available.

There is a change... button for each bus available. Click this button to open a dialog box to change
the bus parameters. A detailed description of those dialog boxes can be found in the following
chapter Configuring Communication, page 37.
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Option Description

Options tab
Depending on the version of the controller there may be an Options tab (version 2.40 or greater).
Here you can define an input for an External Reset and an output for External Error Signaling.

The External Reset input can be one of the inputs i01..i16 or i01..i32.

With an external contact connected to this input the External Error status of the controller can
be reset remotely. The contact behaves in the same way as the reset button at the front of the
controller. Only exception is that if the contact is closed while power cycle the controller will not be
reset to default values. So the configuration will stay valid. Refer to the Hardware Manual for more
details.

You can use one of the 8 outputs of the controller for External Error Signaling. This output will be
active in case the controller is in External Error state. So the error can be indicated by a
connected signaling device or by a non-safety-related controller. The state of this output is the
same as of the External Error LED at the front of the controller.
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Configuring Communication

Modbus
You can access the Modbus dialog box either by using the corresponding change... button
in the Communication tab of the controller Properties dialog box (right-click the controller
symbol and select Properties) or by using the menu Controller > Controller Setup (Bus
Configuration) > Modbus.

The Modbus Parameters dialog box allows you for the up to 8 controllers in a configuration
to select whether a controller is connected to the bus, to define the bus Address of the
controller, the Baud Rate and the Parity of the bus.

If you want to use different Modbuses select the appropriate check box. In this case you can
define different baud rates and parity settings for each controller.

Pressing the Download button starts the transfer of the communication parameters (but not
the configuration) to the connected controller.

The download has to be done for each controller separately.

The communication parameters are also transferred when the configuration is downloaded
to a controller.
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CANopen
If your controller is equipped with the CANopen option, you can access the CANopen dialog
box either by using the corresponding change... button in the Communication tab of the
controller Properties dialog box (right-click the controller symbol and select Properties) or
by using the menu Controller > Controller Setup (Bus Configuration) > CANopen.

The CANopen Parameters dialog box allows you for up to 8 controllers in a configuration to
select whether a controller is connected to the bus, to define the bus Address of the
controller and the Baud Rate of the bus.

For controllers with a firmware version of 2.40 or greater you can also decide which set of
PDOs to be used.

Pressing the Download button starts the transfer of the communication parameters (but not
the configuration) to the connected controller.

The download has to be done for each controller separately.

The communication parameters are also transferred when the configuration is downloaded
to a controller.
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Profibus
If your controller is equipped with the Profibus option, you can access the Profibus dialog
box either by using the corresponding change... button in the Communication tab of the
controller Properties dialog box (right-click the controller symbol and select Properties) or
by using the menu Controller > Controller Setup (Bus Configuration) > Profibus.

The Profibus Parameters dialog box allows you for up to 8 controllers in a configuration to
select whether a controller is connected to the bus and to define the bus Address of the
controller.

Pressing the Download button starts the transfer of the communication parameters (but not
the configuration) to the connected controller.

The download has to be done for each controller separately.

The communication parameters are also transferred when the configuration is downloaded
to a controller.

Setting the Safety-Related Outputs

Introduction
The following information shows you how to set up the safety-related outputs.
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Procedure
Set up the safety-related outputs as follows:

Step Action

1 Click the right mouse button, and select Properties.

The following dialog box appears:

2 Set the properties of the output.

3 Confirm your settings by clicking OK.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

Option Description

Name A specific Name can be assigned to the output.

Stop Category 0/1 A choice can be made between Stop Category 0 (stop immediately)
and Stop Category 1 (stop delayed).

40 33003281.06



Device Library

Option Description

Delay Time Delay Time is defined between 0.1 s and 300 s for the Response Time
of 20 ms and between 0.15 s and 300 s for the Response Time of 30
ms for Stop Category 1

Interruption of Delay Time An input can be defined for an interruption of the delay. If the connection
between the assigned control output and the safety-related input is
opened, the safety-related output is immediately deactivated.

Icon for Block Diagram A window opens in which the block diagram of the concerned
component is represented.

Icon for Help (?) The instruction sheet will be opened at the corresponding chapter of the
component from which help is required.

The last two functions are available for the devices where the block diagram and help icons
appear.

Connecting a Device to a Safety-Related Output

Procedure
To assign a device to the desired safety-related outputs proceed as follows:

Step Action

1 Open one of the device folders.

2 Click the symbol of the device you wish to connect, and drag it to the appropriate safety-related
output symbol in the Configuration window.

Result: When the mouse button is released, the device is connected to the safety-related output,
as represented in a tree structure.

NOTE: When several devices are attached to a safety-related output they are treated
like being connected by a logical AND. Start devices are an exception. They are
assumed to be connected by an OR.
NOTE: This procedure is the same for the functions and devices of the XPSMC Safety
Controller.
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Use of Control Outputs

Introduction
The XPSMC Safety Controller provides 8 control outputs to drive the safety-related inputs.

Each of those control outputs delivers a different pulse signal.

By this the controller is able to determine if the correct signal is applied to a specific input.
Hence a cross-circuit between those inputs can be detected.

If an input receives an incorrect signal, then the related output will be switched off.

For inputs connected to the same control outputs, no cross-circuit can be detected. Carefully
analyze which control outputs can be used for which inputs in your application without
compromising the safety integrity.

WARNING
LOSS OF CROSS-CIRCUIT DETECTION
• Ensure that the required safety level of the application is not compromised by using the

same control output for different devices.
• Carefully analyze and understand how the circuits which are sharing control outputs

interact in your application.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

For some of the devices of the XPSMC Safety Controller the use of control outputs is
optional.

You can connect the appropriate inputs alternatively to an external supply (nominally +24
VDC).

For inputs connected to an external supply instead of a control output there is no cross-
circuit detection.

External means, such as separate cabling or shielding, may be necessary to help achieve
the required safety level.
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WARNING
LOSS OF CROSS-CIRCUIT DETECTION
• Ensure that the required safety level of the application is not compromised by

connecting inputs to an external supply.
• Carefully analyze and understand how loss of cross-circuit detection affects your

application.
• Verify whether alternative means are needed to achieve the required safety level.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Modifying the Properties

Introduction
By dropping a component onto an output, the Properties window of this component will be
automatically opened. This function can be activated or deactivated in the menu Options >
Editor....

Procedure
For modifications of the properties proceed as follows:

Step Action

1 Right-click at a device and select Properties... in the shortcut menu.

In this window, the adjustable parameters of this function can be modified.

2 Indicate the parameters of the device, the control outputs and the safety-related inputs by which
the physical device is connected to the XPSMC Safety Controller.

NOTE: The same control output can be used only once per device. If a control output c1...c8
is already in use by an other device, a * follows the name, for example c2*.

You must ensure that no hazardous situation can occur when this control output is used more
than once, because a cross-circuit, for example, is no longer detected (refer to the hazard
message hereafter).

NOTE: If a safety-related input is already used, it does not appear in the list of available
safety-related inputs. You cannot use the same safety-related input multiple times (except
for the selector switch device).
NOTE: Control output used in safety mats cannot be used elsewhere in the configuration.

3 Confirm the defined parameters with OK.

33003281.06 43



Device Library

Cross-circuits between inputs driven by the same control outputs are not detected.

WARNING
LOSS OF CROSS-CIRCUIT DETECTION
• Ensure that the required safety level of the application is not compromised by using the

same control output for different devices.
• Carefully analyze and understand how the circuits which are sharing control outputs

interact in your application.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Monitoring Devices

Overview
This section contains the description of the folder Monitoring Devices.

Emergency Stop

Introduction
The Emergency Stop folder contains the two device symbols for the one channel and two-
channel emergency stop.
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Dialog Box Settings
You can make the following settings in the Emergency Stop dialog box:

The table describes the setting possibilities:

Option Description

Name A specific Name can be assigned to this device.

Function You can choose between a one channel switch and a two channel switch.

Inputs The inputs to connect the emergency stop button to must be indicated here. You also
need to choose the control outputs or alternatively external supply (nominally +24 VDC)
to drive the inputs.

NOTE: If the inputs are supplied externally, no cross-circuit detection is available.
You may need to achieve the required safety level by other means. For further
information refer to chapter Use of Control Outputs, page 42.

Safety Guards

Introduction
NOTE: One of the 3 starting devices: automatic starting, non monitored starting or
monitored starting must be assigned to each safety guard device. The corresponding
safety-related output cannot be activated without this assignment.
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The Safety Guards folder contains 3 device symbols: protection guard with 1-channel,
protection guard with 2-channels and protection guard with 2-channels and lock (3
channels).

Dialog Box Settings
The Safety Guard dialog box allows you to make the following settings:

The table describes the Parameters:

Option Description

Name A specific Name can be assigned to the device.

Function A choice can be made between a protection guard with 1 limit switch one channel, w/o
lock, 2 limit switches two channels, w/o lock or 2 limit switches with lock two
channels, with lock.

Safety Guard with 1
channel, w/o lock

In the Options field, you can define whether a Start Interlock is to be carried out.
During the Start Interlock, the protection guard must be opened once and then closed
again before the machine can start, to verify if the connected contact is operative.

In the Inputs group box, the input to connect channel 1 to must be indicated. You also
need to choose the control output or alternatively external supply (nominally +24 VDC)
to drive the input.

NOTE: If the input is supplied externally, no cross-circuit detection is available. You
may need to achieve the required safety level by other means. For further
information refer to chapter Use of Control Outputs, page 42.
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Option Description

Safety Guard with 2
Channels, w/o Lock

In the Options field, you can define whether a start interlock is to be carried out. During
the start interlock, the protection guard must be opened once and then closed again
before the machine can start, to verify that the connected contacts are operative. A
synchronization time, during which contacts channel 1 and channel 2 must operate, can
be defined. If this time is exceeded, the assigned safety-related output will not be
activated. For the response time of 20 ms, the range is 0.5...2.5 s; for the response time
of 30 ms, the range is 0.45...2.4 s (synchronization time).

In the Inputs group box, the inputs to connect channel 1 and channel 2 to must be
indicated. You also need to choose the control outputs or alternatively external supply
(nominally +24 VDC) to drive the inputs.

NOTE: If the inputs are supplied externally, no cross-circuit detection is available.
You may need to achieve the required safety level by other means. For further
information refer to chapter Use of Control Outputs, page 42.

Safety Guard with 2
Channels, with Lock

In the Options field, you can define whether a start interlock is to be carried out. During
the start interlock, the protection guard must be opened once and then closed again
before the machine can start, to verify if the connected contacts channel 1, channel 2
and lock are operative. A synchronization time, during which contacts channel 1 and
channel 2 must operate, can be defined. If this time is exceeded, the assigned safety-
related output will not be activated. For the response time of 20 ms, the range is
0.5...2.5 s; for the response time of 30 ms, the range is 0.45...2.4 s (synchronization
time).

The inputs used must be indicated in the Inputs group box. You also need to choose
the control outputs or alternatively external supply (nominally +24 VDC) to drive the
inputs.

NOTE: If the inputs are supplied externally, no cross-circuit detection is available.
You may need to achieve the required safety level by other means. For further
information refer to chapter Use of Control Outputs, page 42.

Light Curtains (Electro Sensitive Protective Equipment
(ESPE)) of Category 4 without Muting

Introduction
The Light Curtains folder contains two device symbols:

Light curtain (ESPE = Electro Sensitive Protective Equipment) with Transistor Outputs
and with Relay Outputs with and without muting.

NOTE: One of the three starting devices: automatic start, non-monitored start or
monitored start must be assigned to each light curtain device. The corresponding safety-
related output cannot be activated without this assignment.

For the light curtain with transistor outputs, the light curtain verifies its safety-related outputs
(OSSD = Output Safety Switching Device) by a short interruption. The light curtain safety-
related outputs must be connected to different XPSMC Safety Controller safety-related
inputs.
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This output test is not, however, possible for the output and is thus performed by the
XPSMC Safety Controller. To provide cross-circuit monitoring, the light curtain safety-related
outputs must be connected to different XPSMC Safety Controller safety-related inputs and
control outputs.

For the light curtain safety-related outputs the following synchronization time range is
available:

Response Time Synchronization Time

20 ms 0.5...5.0 s

30 ms 0.45...4.95 s

If the time difference between the tripping of the two safety-related outputs (OSSD) is
outside this range, the safety-related output affected will not be activated.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:

Option Description

Name A specific Name can be assigned to the device.

Function A choice can be made between the light curtain with a Transistor Output and Relay
Output.
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Option Description

Options and Sync
Time

You can define whether a Start Interlock is to be carried out. During the start interlock,
the light curtain protection field must be interrupted once and validated again, before
activating the XPSMC Safety Controller safety-related outputs. A synchronization time
during which contacts channel 1 and channel 2 must close can also be entered. If this
time period is exceeded, the assigned safety-related outputs are not activated. The
response time period of 20 ms can be defined in the range between 0.5 s and 5.0 s, and
a response time of 30 ms - in the range of 0.45...4.95 s (synchronization time).

Inputs The safety-related inputs to which the light curtain safety-related outputs (OSSD 1 and
OSSD 2) are connected need to be selected here. In case of light curtains with relay
outputs, you also need to define the Control Outputs.

NOTE: In order to drive the relay outputs by an external supply (not by control
outputs), use the Transistor Output option. You may need to apply external
means to compensate for the loss of cross-circuit detection. For further information
refer to chapter Use of Control Outputs, page 42.

Light Curtain with Muting

Introduction
The Light Curtain with Muting folder contains two device symbols:

Light curtain (ESPE = Electro Sensitive Protective Equipment) with transistor outputs or
relay outputs, and with muting function.

The muting function can be used to bypass the protection field of a light curtain (ESPE) in
order, for example, to bring a part to be worked into and/or out of the working area.

Show a muting example:
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The muting function is controlled by four additional sensors belonging to two groups (A and
B), and can only be activated when the safety-related outputs have already been activated
(the protection field is then free). If not, the activation of the muting function produces an
error message and the safety-related outputs remain deactivated. Muting operates
according to a suitable order of the muting sensors in both directions of transport, and thus
inside and outside the working area again.

The muting sensors of groups A and B must be activated during a variable synchronization
time tsyn (0.5...3 s with the response time of 20 ms or 0.6...3 s with a response time of 30 ms
or to infinity), in order to trigger the muting function. A muting time tM can also be adjusted
from 0.5...10 min or to infinity. During this time, the conveyed goods can pass through the
activated protection field, without the XPSMC Safety Controller safety-related outputs
switching off the machine. If this time is exceeded, an error message appears and the
safety-related outputs are deactivated.

The override button is used to bypass the protection field manually. This is necessary, for
example, when the muting function is activated and when conveyed goods have entered
and blocked in the light curtain protection field (ESPE). Through this option, the goods can
be withdrawn from the machine, in spite of the light curtain (ESPE). To help prevent
inappropriate use, the override function can only be activated for up to 10 min. After this
time, the override is canceled and the safety-related response is activated.

To create the muting signal, sensors with output, or mechanical limit switches are suitable
for differentiating between individuals and goods. At the same time, all easily defeated
safety-related means must be prevented.

On entering the working area, use a light signal to announce the muting status for muting
operation; this signal must be connected between terminal H1 and the XPSMC Safety
Controller supply voltage (terminal A1). If an error occurs at the level of this light signal
(cross-circuit, interruption), the muting function is immediately de-activated and an error
message appears. The safety-related outputs are then deactivated.

Sources of white light with an illumination surface of 1 cm2 and a brightness of at least 200
lm/m are used as a light signal. The current of this light source could vary from 20...350 mA.

The light signal illuminates when the muting signals are generated and announces the
bypassing of the light curtain protection function (ESPE):

• A new cycle is only initiated with the starting control when no muting signal is required
and when the protection field is free.

• During the time a muting signal is produced, no unauthorized personnel are allowed to
enter the working area.

The muting function meets the requirements of PL e, category 4 according to ISO 13849-1.
For monitoring of the muting lamp, a minimum duration of 500 ms for muting is necessary.

Photoelectric muting sensors must operate in dark switching mode, in order to produce the
output signal when a light ray is interrupted.
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Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:

Option Description

Name A specific name can be assigned to this device.

Function A choice can be made between the light curtain with a transistor or relay output. The
device symbol is adapted to the choice made.

Options You can define whether a start interlock is to be carried out. During the start interlock,
the light curtain protection field must be interrupted once and validated again before
activating the XPSMC Safety Controller safety-related outputs.

Inputs The safety-related inputs to which the light curtain safety-related outputs (OSSD 1 and
OSSD 2) are connected need to be selected here. In case of light curtains with relay
outputs, you also need to define the Control Outputs.

NOTE: In order to drive the relay outputs by an external supply (not by control
outputs), use the Transistor Output option. You may need to apply external
means to compensate for the loss of cross-circuit detection. For further information
refer to chapter Use of Control Outputs, page 42.

When pressing the Muting button, you get the following Muting Parameters window.
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The Muting Parameters window offers the following options:

The following table describes the parameters of the dialog box:

Option Description

Options Muting Time Monitoring:

The optional Muting Time indicates the maximum time the muting function is allowed
to operate. Exceeding this time with the muting function still activated causes an error
message. The Muting Time have the range of 0.5...10 min.

Override Time: The Override Time indicates the maximum time during which the
relieve time function can be activated. The default value set is 10 min. The Override
Time has the range of 0.5...10 min.

Synchronization Time Monitoring:

The optional Sync Time is the time during which the muting sensors of groups A and
B must be activated before muting is started. If this time is exceeded, the muting
function is not activated. For a response time of 20 ms, the range is 0.5...2.5 s, and for
a response time of 30 ms, the range is 0.45...2.4 s for the Sync Time.

Inputs The override input, the 2 groups A and B of muting sensors and the control outputs to
which the XPSMC Safety Controller are connected to the light curtain, must be
indicated in the Inputs group box.

The 2 groups A and B of muting sensors must be connected to different control
outputs.

Magnetic Switch

Introduction
The Monitoring Devices folder contains the Magnetic Switch control device symbol.
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The Magnetic Switch consists of an opening contact and a closing contact, which must be
actuated within the Synchronization Time, otherwise the safety-related outputs affected are
not activated.

Dialog Box Settings
The parameter setting window offers the following settings:

The table describes the following setting possibilities:

Option Description

Name A specific Name can be assigned to this device.

Options and Sync
Time

You can define whether a Start Interlock is to be carried out. During the Start
Interlock, the magnetic switch must be actuated once before the machine is started
and then de-activated again to verify whether the connected contacts are also
operating. For the response time of 20 ms, the range is 0.5...2.5 s, and for the response
time of 30 ms, the range is 0.45...2.4 s for the Synchronization Time.

Inputs The inputs used must be indicated here.

You also need to choose the control outputs or alternatively external supply (nominally
+24 VDC) to drive the inputs.

NOTE: If the inputs are supplied externally, no cross-circuit detection is available.
You may need to achieve the required safety level by other means. For further
information refer to chapter Use of Control Outputs, page 42.
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NOTE: If you connect the magnetic switches in series, the maximum Category you can
achieve is Category 3.

You can connect in series a maximum of
• 3 magnetic switches with LED
• 6 magnetic switches without LED

Two-Hand Control Type IIIA/IIIC

Introduction
The Monitoring Devices folder contains the Two-Hand Controls folder. In this folder you can
find the device symbols for a Two-Hand Control Type IIIA and a Two-Hand Control Type IIIC
according to ISO 13851.

The two buttons of a two-hand control have to have at least one normally open (NO) and
one normally closed (NC) contact.

These buttons must be actuated within the synchronization time frame of 0.5 s to obtain
switching of the safety-related output.

When this time is exceeded, the assigned safety-related output will not be activated.

After releasing at least one of the buttons the output becomes inactive and cannot be
activated again until both buttons were released.

For Two-Hand Controls of Type IIIA it is sufficient to have one button with an NO contact
and another button with an NC contact.

For Two-Hand Controls of Type IIIC each button has to have a NO and a NC contact.

Dialog Box Settings
The Two-Hand Control provides the following settings:
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Type IIIA Type IIIC

Option Description

Name A specific name can be assigned to the device.

Function You can select Type IIIA or Type IIIC.

Inputs The control outputs and the safety-related inputs to which the two-hand control buttons
are connected must be indicated in the Inputs field.

For Type IIIA controls 2 inputs are to be used.

For Type IIIC controls 4 inputs are to be used.

The use of control outputs is optional. Alternatively the contacts can be driven by the
external supply (nominally +24 VDC).

NOTE: If the control outputs are not used, external means may need to be applied
to achieve the required safety level. For further information refer to chapter Use of
Control Outputs, page 42.
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Safety Mat

Introduction
NOTE: 1 of the 3 starting devices: automatic starting, non monitored starting or
monitored starting must be assigned to each switching mat function. The corresponding
safety-related output cannot be activated without this assignment.

The Monitoring Devices folder contains the Safety Mat function symbol.

The switching mat consists of two pairs of metal leads that are cross-circuited when the mat
is walked on. The XPSMC Safety Controller safety-related outputs are then immediately
deactivated. To be able to detect this cross-circuit, the four connection leads must be
connected to different safety-related inputs and control outputs.

Types: see Technical Specifications, Hardware Manual.
NOTE: The control outputs used for this device cannot be used for any other device.

WARNING
LOSS OF SAFETY INPUT-CROSS CONNECTION DETECTION

In Safety Mat applications, ensure that all four connection leads are connected to different
safety-related inputs and control outputs.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:
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Option Description

Name A specific name can be assigned to this device.

Inputs The control outputs and the safety-related inputs to which the safety switching mat is
connected must be indicated in the Inputs group box.

Zero Speed Detection

Introduction
The Monitoring Devices folder contains the symbol Zero Speed Detection device symbol.

This device detects the zero speed of a motor or a shaft. To enter the motor rotational
speed, an encoder wheel and two PNP sensors are required as indicated in figure
Functional Diagram, page 180. These sensors can only be connected to XPSMC Safety
Controller safety-related inputs i01 and i02. If these inputs are already used, the application
generates an advisory message.

Operating Conditions
Comply with the following points for this device:

• The sensors must be arranged so that only 1 sensor is activated at any given time (=
HIGH-Signal).

• If both sensors are in the LOW state, a cable break error message is indicated and the
corresponding outputs are deactivated.

• If both sensors are in the HIGH state after power on of the XPSMC Safety Controller, a
notification is available via Modbus RTU, or via the configuration terminal (PC), and the
corresponding outputs are deactivated. After a zero speed detection followed by
subsequent motion the notification is reset.

• If zero speed is already detected and both sensors are in HIGH state, a notification is
available via Modbus RTU, or via the configuration terminal (PC), and the
corresponding outputs are activated.

• If only 1 sensor produces a dynamic signal after a zero speed, an error message
appears after 30 s and the corresponding outputs are deactivated.

• If, after the XPSMC Safety Controller has started, both sensors are in the LOW state,
an error message is available via the Error LED on the XPSMC Safety Controller and
Modbus RTU, or via the configuration terminal (PC).
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NOTE: You can only use one Zero Speed Detection per XPSMC Safety Controller,
because there are only two counter inputs (i01 and i02) per controller. For the same
reason you cannot use the Zero Speed Detection device simultaneously with the Shaft/
Chain Break Monitoring device on the same XPSMC Safety Controller.
NOTE: The output will be activated if the sensors detect no motion.

Sensor States and Behavior
Switch-on Sequence

State of Sensor 1 0 0 (*) 1

State of Sensor 2 0 1 (*) 1

Behavior Error Message Zero Speed Notification (**)

Output 0 1 0

Operation

State of Sensor 1 0 0 (*) 1

State of Sensor 2 0 1 (*) 1

Behavior Error Message Zero Speed Notification

Output 0 1 1

* If the state of the sensors is inverse, the behavior is identical.

** If the firmware version is earlier than 2.34 an error message (cross circuit between
inputs) appears instead of a notification. This error message must be
acknowledged with the reset button.

NOTE: When XPSMC••Z•• with a firmware version earlier than 2.34 starts its
function with both sensor inputs at HIGH, then the Short circuit between
inputs stays ON.

Error Message External error messages must be acknowledged with the reset button.

Notification A notification, sent via Modbus, does not need to be acknowledged. As soon as the
sensor states change, it will be acknowledged automatically.

Calculation
Both sensors give a frequency depending on the numbers of cogs and the revolution per
minute:
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or

where

f = Pulse frequency of the sensors in Hertz

n = Rotational speed of the encoder wheel in revolutions per minute

z = Encoder wheel number of cogs

WARNING
UNINTENDED EQUIPMENT OPERATION

Do not use the XPSMC Safety Controller in applications where the pulse frequency
requirement for detection of cogs on a rotary machine exceeds 450 Hz.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Examples
Example 1: Machine with 3000 rpm and an encoder wheel with 26 cogs:

1300 Hz is not authorized, because it is greater than 450 Hz.

Example 2: The same machine (3000 rpm) and an encoder wheel with 8 cogs:

400 Hz is authorized, because it is smaller than 450 Hz.

Switching Frequency
The frequency limit, below which the zero speed is detected and the safety-related outputs
activated, can be adjusted by the user within a range of 0.05...20 Hz.
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Example: A 8-cog encoder wheel is located above a shaft. A zero speed is detected when
the speed is less than 10 rpm.

A switching frequency of 1.33 Hz must be indicated to detect a zero speed.
NOTE: A frequency calculator is included in the properties determination menu. Enter
the number of cogs and the zero speed limit in rpm, and the frequency limit to be set is
calculated automatically.

The switching from Motor Operation to Zero Speed (= activation of safety-related outputs)
only occurs when

• one safety-related input contains a HIGH signal and
• the other input contains a LOW signal and
• the frequency on the two inputs is lower than the value entered.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:

Option Description

Name A specific name can be assigned to this device.

Zero Speed
Frequency

The frequency limit, below which the zero speed must be detected and the safety-
related outputs activated, must be indicated in this field, as indicated above. For the
response time of 20 ms, the range is 0.05...20 Hz, and for the response time of 30 ms,
the range is 0.05...16.7 Hz for the Zero Speed Frequency.
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Option Description

Frequency
Calculator

A dialog box opens when you click here.

Inputs (Fixed) i01 and i02

The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:

Option Description

Rotational Speed
Limit

The desired rotational speed limit (in rpm) to detect a zero speed.

Cogs on Encoder
Wheel

The number of cogs.

Frequency Limit The frequency limit to be set is calculated automatically; it can be adjusted using the
Apply button in the Properties menu.
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Safety-related inputs i01 and i02 are already automatically indicated in the Inputs field. This
device cannot operate with other inputs. If inputs i01 and/or i02 are already used, the
following window appears to help resolve the conflict:

The table describes the following setting possibilities:

Option Description

Manually or As a user, you assign other safety-related inputs manually to the function using ii01
and/or i02. When OK is clicked, the Properties window of the concerned devices will
be opened.

Automatically The software automatically assigns other safety-related inputs to the function using i01
and/or i02 according to 1 of 3 options:

1. shift all inputs
The safety-related inputs are shifted as a block. Inputs that are not used and are
available may also be shifted.
For example, i01 becomes i03, i02 becomes i04 and i04 becomes i06.

2. move up inputs
The safety-related inputs are shifted as a block. Inputs that are not used and are
available may also be shifted, and spaces thus filled.
For example, i01 becomes i03, i02 becomes i04 and i04 becomes i05.

3. replace only concerned inputs
Only the inputs that are used (i01 and/or i02) are shifted to the next free safety-
related inputs. This is the default option.
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Injection Molding Machine

Introduction
NOTE: 1 of the 3 starting devices: automatic starting, non monitored starting or
monitored starting must be assigned to each injection molding machine device. The
corresponding safety-related output cannot be activated without this assignment.

The Specific Functions folder contains the Injection Molding Machine device symbol for
monitoring an injection molding machine with a protection guard, as indicated in figure
Wiring Diagram, page 186.

The 3 limit switches Channel 1, Channel 2 and Valve must then be connected to various
control outputs and safety-related inputs, to provide cross-circuit monitoring. The injection
molding machine is activated according to the switching states of limit switches Channel 1,
Channel 2 and Valve, in accordance with the function diagram in figure Functional Diagram,
page 183. A Start Interlock is, in this case, mandatory, i.e. the protection door must be
opened once and then closed again, to make starting possible.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:
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Option Description

Name A specific name can be assigned to this device.

Sync Time A synchronization time, during which contacts channel 1 and channel 2 must close,
must be entered in this field. If this time is exceeded, the assigned safety-related
outputs are not activated. For the response time of 20 ms, the range is 0.5...2.5 s, and
for the response time of 30 ms, the range is 0.45...2.4 s for the Synchronization Time.

Inputs The safety-related inputs and control outputs used must be indicated in this field.

Hydraulic Press Valve Monitoring

Introduction
The Specific Functions folder contains the Hydraulic Press Valve Monitoring device symbol
for monitoring a hydraulic press valve, as indicated in figure Wiring Diagram, page 188.

Using this device, a hydraulic press with safety valves with three position switches or with
PNP sensors Valve C to Valve C+O can be connected to the XPSMC Safety Controller, as
shown in the figure Wiring Diagram, page 188. The press control delivers the press opening
and closing signals. Each time the leading edge of one of the two press control signals,
OPEN PRESS or CLOSE PRESS, goes positive, a configurable time window is generated,
during which the XPSMC Safety Controller waits for a response from the appropriate valve
position switch (Valve C and Valve C+O for press closing, Valve O for press opening). If this
time window is exceeded, the corresponding safety-related outputs are deactivated.

If signals Valve C to Valve C+O appear in an order other than the one shown in figure
Functional Diagram, page 187, the affected safety-related outputs of this function are then
deactivated and an error message appears.

This function thus delivers the CLOSING AUTHORIZATION signal to a safety-related output,
if the CLOSE PRESS signal is active and if Valve C and Valve C+O are closed in the time
window.

The OPENING AUTHORIZATION signal will also be activated on a safety-related output, if
the OPEN PRESS signal is active and if Valve O is closed in the time window.

When this device is selected, it is necessary to assign the OPENING AUTHORIZATION
function to a safety-related output and the CLOSING AUTHORIZATION function to another
safety-related output.
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This is to be done by the window that appears:

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:

33003281.06 65



Device Library

Option Description

Name A specific name can be assigned to this device.

Options A synchronization time, during which the respective contacts Valve C/Valve C+O and
Valve O/Valve C+O must close, can be entered in this field. If this time is exceeded, the
corresponding safety-related outputs are deactivated. For the response time of 20 ms,
the range is 0.1...1.5 s, and for the response time of 30 ms, the range is 0.15...1.5 s for
the Synchronization Time.

Inputs The safety-related inputs and the control output used must be indicated here. Switches
Valve C to Valve C+O must be connected directly to the +24 V supply voltage. The two
contacts for OPEN PRESS and CLOSE PRESS can operate with the same control output.

Optionally, an input to bypass the monitoring of the valves can be chosen.

If the bypass is used, Valve C, Valve O and Valve C+O will not be monitored and have
no influence on the position of the press. The safety-related outputs are only dependant
on the situation of the OPEN and CLOSE contacts.

Hydraulic Press 2

Introduction
The Specific Functions folder contains the Hydraulic Press 2 device symbol for a hydraulic
press with valve monitoring and optional overtravel monitoring, as indicated on the Wiring
Diagram, page 188.

This device provides a mode selector switch function for the operation modes Inching,
Single Stroke and Automatic of the hydraulic press.

The press safety valves and optionally a top dead center (OT) and a bottom dead center
(UT) contact are monitored according to the selected mode.

Optionally the overtravel of the press can be verified at start up.

The use of the Open and Close signals is mandatory when Automatic mode is selected.
The use of the Open command is also necessary when mode Inching is selected.

The Hydraulic Press 2 device can be attached to outputs only.

When you drop the Hydraulic Press 2 device onto an output, the window shown below
appears.
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Here you need to select if the output enables either the OPENING or the CLOSING
movement of the press and which output to be used for the opposite movement. There are 2
outputs needed for a Hydraulic Press device.

Once the outputs are selected the Hydraulic Press 2 dialog box appears as shown in the
figure below.

Dialog Box Settings
The Hydraulic Press 2 dialog box allows the following settings:
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Option Description

Name A specific name can be assigned to the device.

Inputs/Options Here you need to select the inputs to connect the press safety valves C (closing), O (opening), C+O
(closing and opening) and to define a synchronization time (Sync Time), in which these valves
must be actuated.

For a response time of 20 ms, the range is 0.1...1.5 s; for a response time of 30 ms, the range is
0.15...1.5 s.

If the time is exceeded before the valves react as expected, then the corresponding outputs are
deactivated.

If you chose to use the TDC (OT) and BDC (UT) contacts, you need to select the inputs to connect
these contacts.

If Use Overtravel Monitoring is selected, inputs for the overtravel contact (NWK) and the pressure
contact of the hydraulic pump (Kx) must be defined.

Also the use of a Open and a Close signal can be declared. Those signals may be generated by
external contacts or by a non-safety-related controller. If mode Automatic is used then Open and
Close signals are mandatory.

Depending on the selected mode and chosen options the use of some of the inputs may become
mandatory. Some inputs share common control outputs.

An additional option available for controllers with firmware version 2.40 or greater is to store the last
error generated by the press.

If selected the press will stay in error state until the error is reset by activation of the Reset input.
This is true also in case of a power cycle. Connect a key switch to the Reset input.

68 33003281.06



Device Library

Option Description

Mode Selector
Switch

The following operation modes are available:
• Mode Off

If no input of the mode selector switch is active the press is assumed to be off. Both safety-
related outputs are off and no movement is enabled.

• Mode Inching
In inching mode the position switches OT and UT as well as the switches of the valves O, C
and C+O are not be monitored. The movement of the press is controlled by the status of the
safety-related means (e.g. two-hand control) attached to the press device only. To enable an
upstroke the Open input need to be active.

• Mode Single Stroke
If the safety-related means are valid and the press monitoring does not detect an error the
press performs one stroke. If TDC is reached, i.e. the stroke ends, the movement stops even
if all conditions are still valid. To start the next cycle the safety-related means need to be
deactivated and activated again, e.g. a two-hand control has to be released and pressed
again.
If the safety-related means or monitoring result becomes invalid while downstroke the stroke
will be interrupted. On upstroke the safety-related means are muted.

• Mode Automatic
The function of the automatic mode is equal to that of the single stroke mode with the
difference that the press movement does not stop after the first cycle. The press keeps
running until the safety-related means become invalid or an error is detected.
The movement is controlled by the Open and Close signals.

For controllers with a firmware version of 2.40 or later there is an option to prevent the need to re-
operate the devices attached at the press after the operation mode was changed. The re-operation
of only one device is sufficient to start a new cycle then; for example, in case not only a two-hand
control but also safety guards are attached to the press which normally does not need to be tested
cyclically.

WARNING
UNINTENDED EQUIPMENT OPERATION

Ensure that adequate safety-related measures are effective for each person working on
the press.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Eccentric Press

Introduction
The Specific Functions folder contains the Eccentric Press symbol.
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The eccentric press device is intended to monitor the operation of an eccentric press
including stopping at the top dead center (OTS), the overtravel and optionally the press
safety valve (PSV).

The press must be operated with a two-hand control device. A representation of the two-
hand control has to be attached to the Eccentric Press symbol in the configuration tree.

The XPSMC Safety Controller safety-related outputs are activated as long as the start signal
is active at the beginning of the cycle and the position switches OTS, UN,PSV1, and PSV2
deliver the signals throughout the cycle.

To enable cross-circuit detection, the position switches must be connected to different
safety-related inputs and control outputs.

The function detailed operation differs according to the selected operating mode.

Position switches OTS and UN detect the press movement and in particular stopping at the
top of the dead center OTS.

The control cams are shown on the following functional diagram:

Position switches PSV1 and PSV2 monitor the status of the press safety valve. For the
response time of 20 ms, the range is 0.1...1.5 s, and for the response time of 30 ms, the
range is 0.15...1.5 s for the Synchronization Time. If this time is exceeded before both
valve contacts were operated, an error message appears, and the corresponding safety-
related outputs are deactivated.
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Also if one of the other safety-related inputs delivers an incorrect signal, an error message
appears, and the corresponding safety-related outputs are deactivated.

To reset an overtravel error, a valve error, or an error at the UN or OTS position switches,
the Reset input must be actuated. These error states will not be cleared by switching off the
controller.

Dialog Box Settings
The Eccentric Press dialog box provides the following setting possibilities:

Setting Description

Name A specific Name can be assigned to the device.

Options The valve monitoring can be activated, and the Synchronization Time for the contacts at the
valves PSV1 and PSV2 can be adjusted. For the response time of 20 ms, the range is 0.1...1.5
s, and for the response time of 30 ms, the range is 0.15...1.5 s
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Setting Description

Inputs Relation between inputs and control outputs need to be selected.
• At the OTS input the top dead center (TDC) contact is to be connected.
• At the UN input the bottom dead center (BDC) contact need to be connected.
• The PSV1 and PSV2 inputs are for the monitoring contacts of the 2 halves of the press

safety valve (PSV).
• The Continuous Off input is used in Continuous and Continuous Automatic mode,

see below. The input is low active.
• The Reset input is used to reset the error state of the press. Connect a key switch.

Mode Selector
Switch

The following operation modes are available:
• Mode Off

The press is deactivated and the related safety-related output is turned off.
• Mode Inching

Position switches OTS and UN as well as the switches of the valves PSV1 and PSV2 will
not be monitored. The movement of the press is controlled by the status of the safety-
related means (for example Two-Hand Control) attached to the press device only.

• Mode Single Stroke
The movement of the press starts when the two-hand control is activated, and the press
is in TDC. As long as the two-hand control signal stays valid and there is no press error
detected the cycle will be continued until TDC is reached again. In TDC the movement
will stop even if the two-hand is still pressed. To restart the press the two-hand need to be
released and pushed again. While upstroke the status of the two-hand is not monitored
(muted).

• Mode Continuous
The behavior of monitoring correspond to that of the mode Single Stroke, however the
press does not stop after one cycle. The movement is continued until the Two-Hand
Control is released or the Continuous Off input is switched off. Dynamic monitoring of
the valve and the monitoring of overtravel will only be performed one time in the
continuous cycle.

• Mode Continuous Automatic
The behavior of monitoring corresponds to that of the mode Single Stroke, however the
press does not stop after one cycle. The movement is continued until the Continuous
Off input is switched off even if the Two-Hand Control was released before. The Two-
Hand Control is required only to start the movement of the press. Dynamic monitoring of
the valve and monitoring of overtravel will only be performed one time in the continuous
cycle.

WARNING
UNINTENDED EQUIPMENT OPERATION

Ensure that adequate safety-related measures are effective for each person working on
the press.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.
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Eccentric Press 2

Introduction
The Specific Functions folder contains the Eccentric Press 2 device symbol.

The Eccentric Press 2 device is intended to monitor the operation of an eccentric press
including stopping at the top dead center (OTS), the overtravel and optionally the press
safety valve (PSV).

The Eccentric Press 2 device is more flexible than the device described in the Eccentric
Press chapter. Also refer to the Wiring diagram, page 198.

In the configuration tree the Eccentric Press 2 device symbol provides 2 logical inputs to
attach devices to. The dedication of those inputs is explained in the following table.

Devices, as for example two-hand controls, light curtains (w/o muting) and safety guards,
can be attached to the inputs as start or safety-related means. Multiple assignments are
possible.

By applying a Selector Switch device to the press the devices used as start or safety-related
means may be changed during operation.

Input Description

Firmware Versions < 2.40

Safety Means and Start The start means (e.g. two-hand control) and the safety-related means (for
example safety guard) attached here have to be operated cyclically.

The operation of the press can be started by any device attached here.

Safety Means for Continuous
Automatic

The devices attached here are monitored in Continuous Automatic mode only.

They do not need to be operated cyclically. To start the automatic mode the
devices at the start input have to be activated.

Firmware Versions ≥ 2.40
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Input Description

Start Means The devices attached here need to be operated cyclically.

Depending on the mode, they may become inactive when a cycle is started.

Safety Means Devices attached here do not need to be operated cyclically.

If they are not valid the operation of the press cannot be stated or has to be
stopped (unless the safety-related means are muted).

Position switches OTS and UN detect the press movement and enable for stopping at the
top dead center. For the functional diagram of the control cams refer to the Eccentric Press
chapter, page 69.

With the valve contacts PSV1 and PSV2 the status of the press safety valve can be
monitored optionally.

The range for the adjustable Synchronization Time is 0.1...1.5 s for a response time of 20
ms and 0.15...1.5 s for a response time of 30 ms. If this time is exceeded before both valve
contacts were operated, an error will be indicated. The corresponding safety-related output
becomes deactivated.

The reset input has to be actuated to reset an overtravel error or an error detected at the UN
or OTS position switches. The error state of the press will not be cleared by resetting or
switching off the controller.

The behavior of the output of the press depends on the operation mode selected. It is
described in the operation Mode Selector Switch section below.
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Dialog Box Settings
The Eccentric Press 2 dialog box provides the following settings:

Option Description

Name A specific name can be assigned to the device.

Valve Monitoring The optional valve monitoring can be activated and the allowable Synchronization Time for the
safety-related valves contacts PSV1 and PSV2 can be adjusted. For the response time of 20 ms,
the range is 0.1 to1.5 s and for the response time of 30 ms the range is 0.15 to 1.5 s.

Shaft Monitoring The optional shaft monitoring can be activated and the allowable Dead Time can be adjusted. The
dead time is the time before the shaft monitoring becomes active after start of the press movement.

For a response time of 20 ms, the range is 0.05...0.50 s and for a response time of 30 ms the range
is 0.06...0.48 s.

If you activate the shaft monitoring option a Shaft/Chain Break Monitoring device will be attached to
the press automatically. This device needs to be configured separately.
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Option Description

Inputs The used inputs and the control output must be indicated.
• At the OTS input the top dead center (TDC) contact is to be connected.
• At the UN input the bottom dead center (BDC) contact need to be connected.
• The PSV1 and PSV2 inputs are for the monitoring contacts of the 2 halves of the press safety

valve (PSV).
• The Continuous Off input is used in Continuous and Continuous Automatic mode, see

below. The input is below threshold (logical 0).
• The Reset input is used to reset the error state of the press. Connect a key switch.
• For the Mode Selector Switch the inputs to activate the different modes need to be defined.

One input only must be active at a time.
• For controllers with firmware version 2.40 or later there is an input to connect a Dynamic

Cam signal. The use of this input is optional. The Dynamic Cam option is described below.
• The inputs that are not driven by a control output need to be connected to the external supply

(nominal +24 V).

Mode Selector
Switch

The following operation modes are available:
• Mode Off

If no mode selection input is activated, Off mode is assumed. The press is deactivated and
the corresponding safety-related output is turned off.

• Mode Inching
Position switches OTS and UN as well as the switches of the valves PSV1 and PSV2 will not
be monitored. The movement of the press is controlled by the status of the start condition
only.

• Mode Single Stroke
The movement of the press starts when the safety-related means are valid, the start is
activated and the press is in TDC. As long as the safety-related and start means stay valid
and there is no press error detected the cycle will be continued until TDC is reached again. In
TDC the movement will stop even if the conditions for movement are still valid. To restart the
press the start means need to be released and activated again.
While upstroke the status of the start and safety-related means is not monitored (muted).

• Mode Continuous
The behavior correspond to that of the Mode Single Stroke, however the press does not stop
after one cycle. The movement will be continued until the start condition or the safety-related
means are no longer valid or the Continuous Off signal is switched off. Dynamic valve
monitoring and monitoring of overtravel will only be performed at the first cycle.

• Mode Continuous Automatic
The behavior correspond to that of the Mode Single Stroke, however the press does not stop
after one cycle. The movement will be continued until the Continuous Off signal is switched off
or the safety-related means become invalid. Dynamic valve monitoring and monitoring of
overtravel will only be performed at the first cycle.

For controllers with a firmware version of 2.40 or later there is an option to prevent the need to re-
operate the devices attached at the press after the operation mode was changed. The re-operation
of only one device is sufficient to start a new cycle then. If, for example, safety guards are also
attached to the press which do not need to be cyclically tested with the two-hand control, the re-
operation of only one device may be preferred..
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Option Description

Options tab For controllers with firmware version 2.40 or later there is an Options tab. The following options are
available:

• By default the start conditions in Continuous Automatic mode can be released right after the
press starts to move. When the press start until BDC option is active then the start
conditions must be activated until bottom dead center to enter the continuous operation.

• With the stop stroke in TDC option the press can be forced to stop in inching mode at TDC
even if the start condition is still valid. When the press stops at TDC, the start conditions must
be deactivated and reactivated to restart the press movement.

• With the do not use Continuous Off in Continuous Mode option active the status of the
Continuous Off signal has no meaning for Continuous Mode. The use of the signal stays
mandatory in Continuous Automatic mode.

WARNING
UNINTENDED EQUIPMENT OPERATION

Ensure that adequate safety-related measures are effective for each person working on
the press.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.
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Dynamic Cam Option
The dynamic cam option is shown in the following functional diagram:

When the speed of the press (cycles per minute) varies, then the start of braking also need
to be variable in order to be able to stop the movement at the top dead center (TDC).

In the above example the braking should start at 270° instead of the invariable, fixed position
of 300° indicated by the UN cam.

To achieve this, the XPSMC Safety Controller optionally allows to consider an external
signal provided by a non-safety-related controller which calculates the variation of speed of
the press and the appropriate braking point in relation to the UN signal. The Dynamic Cam
signal overwrites the UN signal.
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Shaft/Chain Break Monitoring

Introduction
The Specific Functions folder contains the Shaft/Chain Break Monitoring icon. The
device is used to monitor the movement of a cam switch mechanism of an eccentric press,
as shown in the Shaft/Chain-Break Monitoring, page 211. This device is directly linked to the
OTS and UN position switches by a cogwheel sensor and can only be connected either to
input i01 or i02. You can drag and drop the device from the library onto any output of the
controller. For the Eccentric Press 2 device, you can only enable the Shaft Monitoring
device inside the Properties window.

Dialog Box Settings
The parameter setting window provides the following possibilities:

The table describes the following setting possibilities:

Option Description

Name A specific name can be assigned to this device.

Options For the response time of 20 ms, the range is 0.02...0.10 s, and for the response time of 30 ms,
the range is 0.03...0.9 s for the Pulse cycle.

Inputs Only i01 or i02 are selectable.
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NOTE: You can only use 2 different Shaft/Chain Break Monitoring devices in one
XPSMC Safety Controller, because there are only 2 counter inputs (i01 and i02)
available, see also Zero Speed Detection, page 57. If the Shaft/Chain Break Monitoring
is used, no Zero Speed Detection can be used and vice versa.

Seat Valve Monitoring

Introduction
The Specific Functions folder contains the device symbol for monitoring of a seat valve as
shown in figure Wiring Diagram, page 214.

The device senses the start signal for operating the valve with the first input and the answer
signal of the concerned valve contact with the second input.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:
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Option Description

Name A specific name can be assigned to this device.

Options The function of the valve contact can be selected as either NO or NC. For the response
time of 20 ms, the range is 0.1...3.0 s, and for the response time of 30 ms, the range is
0.15...3.0 s for the Synchronization Time.

Inputs After the start signal is given and the valve contact is not operating, the output of the
device is immediately activated and remains activated until the synchronization time is
exceeded. The output only remains activated if the valve contact is operating during the
synchronization time. After this, the valve contact may open and close without
disrupting the output as long as the start signal is maintained. If the start command
disappears, the output will be deactivated.

EDM Devices

Overview
This section contains the description of the Eccentric Press folder.

EDM Device (External Device Monitoring)

Introduction
The EDM Device folder contains the device symbol for monitoring a feedback loop. This
device is used to monitor external devices such as subsequent contactors or relays.

If, for example, external contactors K1 / K2 are activated, the EDM input to which opening
contacts K1 and K2 are assigned must then be opened, by the end of the adjustable
synchronization time at the latest. If this is not the case, an error message appears and the
safety-related outputs concerning K1 and K2 are deactivated.

Before activating the safety-related output, ensure that the EDM input is activated.
Otherwise, an error message appears, and the safety-related output gets deactivated.
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Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:

Option Description

Name A specific name can be assigned to this device.

Options A synchronization time, during which the return circuit must open, can be entered in this
field. If this time is exceeded, the corresponding safety-related output is deactivated.
For the response time of 20 ms, the range is 0.1...0.5 s, and or the response time of 30
ms, the range is 0.15...0.5 s for the Synchronization Time.

If the Synchronization Time monitoring is not activated, it is verified whether the EDM
input is closed immediately before activating the safety-related outputs.

Inputs The safety-related input and the control output must be indicated in this field.

Start Device

Overview
This section contains the description of the Start Device folder.
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Start Device

Introduction
The Start Devices folder contains 3 device symbols for

• Automatic Start,
• Non-Monitored Start,
• Monitored Start.

The functional diagram for these devices is shown, as an example, in figure Functional
Diagram, page 148.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:
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Option Description

Name A specific name can be assigned to this device.

Function You can then select one of the starting devices again in this field. The device symbol in
the configuration tree is adapted automatically.

The following options are available:
• Automatic Start

The safety-related outputs are activated as soon as the starting conditions are
fulfilled. A start button is not necessary.

• Non monitored Start
The safety-related outputs are activated as soon as the starting conditions are
fulfilled and starting is initiated by the start button being pressed. The Start button
does not need to be re-activated to launch the Start device, and the non
monitored start then operates in the same way as the automatic start.

• Monitored Start
In this case, the safety-related outputs are only activated when the starting
conditions are fulfilled and starting is initiated when the start button is pressed
(start on a positive trigger edge) or when the start button is pressed and released
(start on a negative trigger edge). It is possible to define whether starting should
take place on the positive-going edge or negative-going edge of the starting
signal. Unlike non monitored starting, the safety-related output cannot be
activated when the start button is actuated by an XPSMC Safety Controller
Power-Up or when the start button keeps being activated a certain time after the
operation. In this case an error message will be generated.

Options For monitored start, a selection can be made in this field to start on a positive trigger
edge (= starting when the start button is pressed) or to start on a negative trigger edge

(= starting when the start button is released).

Inputs The safety-related input and the control output must be indicated here.

Enabling Devices

Overview
This section contains the description of the Enabling Devices folder.

84 33003281.06



Device Library

Two-Channel or Three-Channel Enabling Device

Introduction
The Enabling Devices folder contains 2 device symbols for the enabling switch. This device
can be used alone on a safety-related output, with a safety guard or together with a safety
guard on the OR device.

NOTE: The enabling device can be dragged and dropped together with a safety guard
onto the OR device. An external switch (usually a key switch) should be used to enable
the input of the enabling device.

With an enabling switch, a safety guard can be bypassed and a hazardous movement can
consequently be started, even with a protection door open, during the fitting out of a
machine for example. The enabling switch does not activate the hazardous movement but
enables the hazardous movement to be actuated.

This function works with a two or three channel enabling switch (Wiring Diagram, page 216
or figure Wiring Diagram, page 218). Category 4 is only achieved when using the 3 position
enabling switch. For the types of enabling switches that can be used, see the Technical Data
chapter of the Hardware instruction manual.

To generate the confirmation signal, the enabling switch must first be set to position 0 and
then to position 1. The authorization is thus activated, as are the XPSMC Safety Controller
safety-related outputs. If the enabling switch reaches position 2, the safety-related outputs
are deactivated. No further enabling will be authorized before the switch has returned to
position 0.
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Dialog Box Settings
The parameter setting window provides the following setting possibilities:

The table describes the following setting possibilities:

Option Description

Name A specific name can be assigned to this device.

Function You can select one of the enabling switches in this field. The switching diagram needed
for the contact switch is schematically illustrated here.

Options You can specify a maximum enable time. If the enabling switch is active longer than this
time, the corresponding safety-related outputs will be deactivated and an error
message will be given. The time is adjustable from 0.5...10 min.

Inputs The safety-related inputs and control outputs used must be indicated in this field. To
provide a cross-circuit detection, the contacts must be set into service on different
control outputs.
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Miscellaneous Devices

Overview
This section contains the description of the Miscellaneous Devices folder, which contains
the logic devices.

Timer

Introduction
The Miscellaneous Devices folder contains the Timer device.

The Timer device facilitates 4 time-dependent behaviors as shown in the figure below. Time
t is adjustable.

1 Input

2 Switch-ON delay

3 Switch-OFF delay

4 Switch-ON pulse

5 Switch-OFF pulse
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Dialog Box Settings
The Timer dialog box provides the following setting:

Firmware version < 2.40 Firmware version ≥ 2.40
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Option Description

Name A specific name can be assigned to this device.

Function One of the 4 operating modes can be selected.
• Switch ON delay

If the input status becomes TRUE the adjustable time delay starts. If the delay has passed
and the input is still TRUE then the result of the Timer becomes TRUE as long as the input
status keeps staying TRUE.
If the input status does not stay TRUE for the whole delay time, then the Timer status will not
become TRUE.
For controllers with firmware version 2.40 or greater, this behavior can be changed by
deselecting the switch-off priority check box. In this case the Timer status can become
TRUE even if the input signal was interrupted during delay time.

• Switch OFF delay
If the input signal becomes TRUE the timer status becomes TRUE too. If the input status
changes to FALSE the adjustable delay starts and the timer status stays TRUE as long as the
delay time is running. If the input status becomes TRUE again while the time delay is still
running then the status of the Timer remains TRUE.

• Switch ON pulse
If the input status becomes TRUE the timer status becomes TRUE too and the adjustable
pulse time starts. If the time has passed the timer status is set to FALSE again.
The Timer status will also be FALSE when the input becomes FALSE during pulse time. Thus
the pulse will be interrupted.
For controllers with firmware version 2.40 or greater this behavior can be changed by
deselecting the switch-off priority check box. In this case the Timer status will be TRUE for
the whole pulse time even if the input status is not.

• Switch OFF pulse
If the input status was TRUE and changes to FALSE then the timer status is set to TRUE and
the adjustable pulse time starts. The timer status stays TRUE until the pulse time passed.

For controllers with firmware version 2.40 or greater, re-triggering can be allowed optionally by
selecting the appropriate check box. When selected, the delay or pulse times will restart when
trigger conditions repeat. The re-triggering and the switch-off priority options exclude each other.

Time The adjustable delay time range is 0.1* to 600 seconds.

(* 0.15 seconds if controller response time is set to 30 ms)

Input If the controller firmware version is less than 2.40 and no other device was selected as an input
then the safety-related input and the control output or external supply used for the input signal must
be indicated here.

For firmware versions of 2.40 or greater, a device has to be attached to the timer symbol to define
the input signal. This may be a Switch device in case an external input shall be used.

For controllers with a firmware version 2.40 or greater, the Timer device needs an input
device (e.g. Switch or Logic device). For firmware versions less than 2.40 the input device is
optional. An external input can also be defined inside the Properties dialog box of the
Timer.
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Pulse Generator

Introduction
In the Miscellaneous Devices folder contains a Pulse Generator device.

The Pulse Generator device provides a configurable pulse signal in dependence of an input
signal.

As long as the input signal is TRUE the output signal will be generated.

When the input signal becomes FALSE, the pulse signal will be stopped and a current pulse
will be interrupted (see image below). The input signal is the result of another device that
need to be attached to the Pulse generator symbol.

1 Input

2 Output
NOTE: The Pulse Generator device is available in firmware 2.40 or greater.
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Dialog Box Settings

The Pulse Generator dialog box allows the following settings:

Option Description

Name A specific name can be assigned to the device.

Pulse The pulse is described by 3 parameters:
• Delay Time td: The time between a valid input signal (input becomes TRUE) and the first

pulse (output becomes TRUE). Allowable range is from 0 to 600 seconds. The default value is
0.

• On-Time ton: The duration of a single pulse (output TRUE). Allowable range is from 0.1* to
600 seconds.

• Off-Time toff: The duration of a pulse pause (output FALSE). Allowable range is from 0.1* to
600 seconds.
(* 0.15 seconds if controller response time is set to 30 ms)

The Pulse Generator device needs an input device (e.g. Switch or Logic device).

Logic Devices

Introduction
The Miscellaneous Devices folder contains a subfolder Logic Devices.
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In this folder the following logic devices can be found:
• AND
• OR
• XOR
• NOT
• RS-Flip Flop

NOTE: The Logic Devices are available in firmware 2.40 or greater.

Attachable to
Logic Devices can be attached to:

• Outputs
• Markers
• other Logic Devices
• Timers/Pulse Generators

Input Restrictions
Devices that cannot be attached to Logic Devices are:

• Emergency Stop (can be attached to outputs only)
• EDM (can be attached to outputs only)
• Hydraulic Press (can be attached to outputs only)
• Eccentric Press (can be attached to outputs only)
• Automatic Start (result is static)
• Closed Tool (result is static)

Input Restrictions for NOT Logic Devices
Specifically for NOT logic devices the possible inputs are restricted to:

• 1 state of another output
• 1 Marker
• other Logic Devices
• Switches
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A maximum of 255 devices can be attached to logic devices. The NOT logic device accepts
only 1 device attached.

AND
The result of an AND is TRUE as long as the result of all attached devices is TRUE.

This device has no editable properties.
NOTE: If there are more than 1 devices are attached to some device in the configuration
tree, those connections are seen as AND connections in most of the cases even if there
is no explicit AND device. Exceptions are connections to Logic Devices (connection
depends on type of device) and connections of start devices (are taken for OR
connections).

OR
The result of an OR is TRUE as long as the result of at least 1 of the attached devices is
TRUE.

This device has no editable properties.
NOTE: If more than 1 start devices are attached to some device in the configuration tree
this connection is seen as an OR connection even if there is no OR device involved
explicitly.

XOR
If there are 2 devices attached to the XOR device the result of an XOR is TRUE as long as
the result of exactly 1 of the 2 attached devices is TRUE.

More generally defined (valid for even more than 2 devices attached) the result is TRUE as
long the count of the TRUE results of the attached devices is odd.

This device has no editable properties.

NOT
The NOT logic device performs an inversion (negation) of its input. The result is TRUE as
long as the result of the attached device is FALSE and vice versa.

The NOT logic device accepts only 1 device attached.
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WARNING
UNINTENDED EQUIPMENT OPERATION
• Ensure that the required safety level of the application is not compromised by using the

NOT logic device.
• Carefully analyze the inputs and outputs to be inverted and understand how the

inversion (negation) affects the application, especially in terms of safety.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Inverted Outputs and inverted Markers are marked in the configuration tree by inversion
(negation) of the original icons. In addition, an advisory message appears when NOT logic
devices are used in a configuration.

This device has no editable properties.

RS-Flip Flop
The RS-Flip Flop device has 2 inputs, the Set (S) and the Reset (R) input.

If the result of the devices attached to the Set input is TRUE then the result of the RS-Flip
Flop (Q) is TRUE.

If the result at the Reset input becomes TRUE the result of the RS-Flip Flop will be reset to
FALSE.

If both inputs are TRUE at the same time then the result of the RS-Flip Flop is determined by
the dominant input.

Which of the inputs is the dominant one can be selected in the Properties window of the
device. By default the Reset input is the dominant one.

The status of the RS-Flip Flop remains unchanged as long as both inputs receive a FALSE
signal.

R S Q

Reset is dominant

Q

Set is dominant

FALSE FALSE Q Q

FALSE TRUE TRUE TRUE

TRUE FALSE FALSE FALSE

TRUE TRUE FALSE TRUE
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In the RS-Flip Flop dialog box, you can select whether the Set or the Reset input is
dominant.

Switches

Introduction
The Miscellaneous Devices folder contains a subfolder Switches.

In this folder the following basic switch devices can be found:
• 1-channel
• 2-channel
• 2-channel antivalent

Switches can be seen as representation of external contacts.
NOTE: The switches are available in firmware 2.40 or greater.

The 3 switches share the same dialog box.
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Dialog Box Settings

The Switch dialog box allows the following settings:

Option Description

Name A specific name can be assigned to the device.

Function One out of the 3 switch types can be selected.

1-channel This device represents a single contact switch. The result of the device is TRUE as long as the
external contact is closed (given the contact is connected to a control output or the external supply).

For this device a start interlock can be defined. When the option is active the external contact has to
be seen open before the result of the device can become TRUE after a power cycle or emergency
stop.

2-channel This device represents a 2-contact switch with similar type of contacts. The result of the device
becomes TRUE when both external switch contacts are closed (given they are connected to a
control output or the external supply).

For this device a start interlock can be defined. When the option is active both contacts have to be
seen open at the same time before the result of the device can become TRUE after a power cycle
or emergency stop.
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Option Description

Optionally a synchronization time monitoring can be configured. When the monitoring is active the
result of the device will not become TRUE if the time between closing of the 2 contacts is longer
than the chosen synchronization time

2-channel
antivalent

This device represents a 2-contact switch with an NO contact and NC contact. The result of this
device is TRUE if the NO contact of the switch is closed and the NC contact is open at the same
time (given they are connected to a control output or the external supply).

For this device a start interlock can be defined. When the option is active the NO contact has to be
open and the NC contact to be closed at the same time before the result of the device can become
TRUE after a power cycle or emergency stop.

Optionally a synchronization time monitoring can be configured. When the monitoring is active the
result of the device will not become TRUE if the time between opening of the NC contact and
closing of the NO contact is longer than the chosen synchronization time.

Options The Start Interlock can be activated.

The synchronization time monitoring (Sync Time Monitoring) can be enabled (except for single
channel switches). If the monitoring is enabled a synchronization time (Sync Time) need to be set.
The range is from 0.5 to 300 seconds if the controller response time was set to 20 ms or from 0.45
to 300 seconds if the response time is 30 ms.

Inputs The inputs to connect the external contacts need to be chosen. It can be defined whether the
contacts are driven by control outputs or by the external supply. In the later case the control outputs
need to be selected.

NOTE: If no control outputs are used, there is no cross-circuit detection for the inputs. External
means may be necessary to achieve the required safety level. For further information refer to
chapter Use of Control Outputs, page 42.

Markers

Introduction
The Miscellaneous Devices folder contains a Marker device.

Markers can be used like Outputs but have no physical representation.

The result of a Marker can be used elsewhere in the configuration as an input signal (as far
as the device specific rules allow).

To use Markers may be of benefit, for example, when provisional results are used at
different parts of the configuration, or to group devices to make a configuration more
structured.

Up to 255 devices can be attached to a Marker. The result of a Marker becomes TRUE
when the results of all the attached devices are TRUE and the start signal is valid. If no start
device is defined for a Marker. It will behave as if start is always valid (automatic start).
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Up to 8 markers can be defined per controller.
NOTE: Markers are available in firmware 2.40 or greater.

Usage
To use a Marker, the marker symbol from the library (see item number 1 in figure below)
needs to be dropped onto the configuration tree.

If it is dropped to the controller symbol, a Marker will be created at the output level.

If the marker symbol is dropped to a device other than a controller, a Marker will be created
at the output level and a copy of this Marker at the device it is dropped onto (given the
specific device accepts markers).

A Marker at the output level accepts the same device attachments as an output.

Copies of those output level Markers can be used elsewhere in the configuration as long as
the specific rules of the target devices allow for it (see item number 2 in figure below).

Each Marker used in a configuration has a representation in the Markers folder of the library
(see item number 3 and 4 in the figure below).
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Copies of Markers
Copies of Markers can be brought into the configuration in 3 ways:

• By dragging-and-dropping the library representation of a Marker into the configuration,
• by dragging the symbol of an output level Marker and dropping it onto the device it

should be used with,
• by copying a Marker at output level (using the Edit menu, the contextual menu or using

Ctrl+C) and placing it at the target device.
The number of copies is not limited. Onto copied Markers no devices can be attached.

The copied Markers can be deleted separately. If an output level Marker is deleted the
copies will be deleted, too.

Markers do not have a Properties dialog box.

Foot Switch Control Device

Introduction
The Miscellaneous Devices folder contains the Foot Switch Control device symbol. The
device monitors a NO and NC contact from one control output.

Dialog Box Settings
The parameter setting window provides the following setting possibilities:
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The table describes the following setting possibilities:

Option Description

Name A specific Name can be assigned to this device.

Options • Start Interlock: Foot switch must be released before starting the foot switch function.
• Sync Time Monitoring: for the response time of 20 ms, the range is 0.5...2.5 s, and for the

response time of 30 ms, the range is 0.45...2.4 s for the Synchronization Time, required for
the 2 inputs, NO and NC.

Inputs The inputs to connect the foot switch to must be indicated here.

You also need to choose the control outputs or alternatively external supply (nominally +24 VDC)
to drive the inputs.

NOTE: If the inputs are supplied externally no cross-circuit detection is available. You may
need to achieve the required safety level by other means. For further information refer to
chapter Use of Control Outputs, page 42.

DANGER
UNPROTECTED MACHINE OPERATIONS

Do not use foot switches on machines without point-of-operation protection.

Failure to follow these instructions will result in death or serious injury.

NOTE: The use of the foot switch requires additional safety-related measures. The foot
switch does not provide technical safety for a press control. Example: In order to control
the continuous mode of a press with the foot switch, additional safety-related means are
necessary (e.g., Safety Guard, Light Curtain).

Selector Switch

Introduction
The Miscellaneous Devices folder contains the Selector Switch device symbol.

You can use the Selector Switch device when different devices shall be selected as safety-
related means or start means alternatively.

The Selector Switch device symbol can be dropped either onto the Eccentric Press 2, the
Hydraulic Press 2 or directly onto an output.

A maximum of 16 devices can be attached to the Selector Switch and up to 6 switch
positions (i.e. selections) are configurable.
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For each switch position you can decide which of the attached devices shall be active. If
multiple devices are selected for 1 position, then the result of the Selector Switch will
become TRUE only if all the activated devices are TRUE.

Which switch position is activated is determined by physical inputs. For each switch
positions used, an input has to be assigned.

Additionally, you can chose whether or not the attached devices need to be re-operated after
the switch position was changed (controller firmware 2.40 or later required).

When the Selector Switch is assigned to a press device, then it can be linked to the
operation mode selector switch of this press device. That means both switches share the
same inputs for activation.

A physical representation would be a selector switch with 2 decks.

In case both switches shall be linked you need to make the input selection for the mode
selector switch of the press before the configuration of the Selector Switch device.

No input selection is possible within the Selector Switch dialog box but the inputs are taken
from the linked press device automatically.

Dialog Box Settings
The Selector Switch dialog box provides the following settings:
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Option Description

Name A specific name can be assigned to the device.

Device Declaration The link switch to the mode selector switch of the press check box is available only when
the Selector Switch is attached to a press device.

When selecting it, you force the Selector Switch to share the same inputs for activation as the
mode selector switch of the press. The inputs of the mode selector switch of the press need to
be defined before this option can be activated. When it is activated, then no inputs may be
selected in the dialog box.

Following the dialog box presents a table with the switch positions in the columns.

With the used check boxes in the first row you can select the positions of the switch to be
used. Alternatively they are set automatically when an input will be selected for a position.

In the Input row you need to choose the inputs to be used to activate the positions. A position
becomes activated when the related input is connected to the external supply. One position
only must be active at a time.

The following rows list the devices attached to the Selector Switch. You may choose for each
position which of the devices shall be activated with that position. Multiple selections are
possible.

By default, all devices need to be re-operated when the switch position was changed. That
means the switch cannot be activated until all attached devices are tested while the devices
are off. Otherwise it is blocked.

For controllers with firmware version 2.40 or greater, the Block after switching check boxes
are available. You can use them to define for each device if it needs to be re-operated, i.e.
tested, or not.

Closed Tool Device

Introduction
The Miscellaneous Devices folder contains the Closed Tool symbol. You can use this device
with a Selector Switch and an additional start device (e.g., Foot Switch Control) on Hydraulic
Press 2 or Eccentric Press 2. You can also move it directly to the safety-related means for
continuous automatic operation of the Eccentric Press 2.

When you configure the Closed Tool device directly to the Safety Means for continuous
automatic operation of the Eccentric Press 2, you also need an external key switch to enable
the continuous automatic operation as well as a signal lamp.

102 33003281.06



Device Library

State of Outputs

Overview
This section contains the description of the Output states folder.

Applying Output States to Other Safety-Related Outputs

Introduction
The Output states folder contains the symbol of the safety-related outputs for each
controller.

By moving the output X symbol on the output Y in the Configuration window, the safety-
related output Y will have the same behavior as the safety-related output X. Other
components can be additionally assigned to the output Y.

The same result will be achieved by moving the output X symbol with the left mouse button
onto the output Y.

Example

In this example, safety-related output o1 is associated with Non monitored Start, Safety
Guard and two-channel Emergency Stop. safety-related output o2 represents the 2nd
channel of this safety function and will behave exactly like o1.

Modifications can only be performed in the original safety function (in this case, safety-
related output o1); they are taken into account automatically in the corresponding safety-
related output.
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Configuration
Overview

This chapter contains the description to create a configuration.

General Information

Overview
This section contains general information to the configuration.

Generals

Introduction
The configuration can be created while the PC is offline, that is without being connected with
an XPSMC Safety Controller, and later sent to the XPSMC Safety Controller.

The creation of a configuration is explained by means of the following application:

The entry of personnel into the working area of the robot arm is prevented by the guard/
protection guard with 2 limit switches. For adjustment and maintenance purposes, the robot
arm may also be controlled when the door is open by using an enabling switch. The choice
of using the guard or enabling switch for functional safety is done by an external selector
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switch mounted near the guard. The functional safety inside or around this cell is further
enhanced with a two-channel emergency stop.

The corresponding wiring diagram could be as follows:

LOGIC Channel 1

Channel 2

XPSMC16
safety controller

Channel 1
Release safety gate

E-Stop

open

Enabling 
switch

Start

(NC)
(NO)

(1)(1)

1 lennahC2 lennahC
Emergency stop

Channel 2

Channel 1

Channel 2

Channel 1

Channel 2

Channel 1

Channel 2

Channel 1

Channel 2

Channel 1

Channel 2

CSECSE

Enable
highspeed

Selector switch S6:
0 - OFF
1 - Guard
2 - Enable switch

ESC External Start Conditions

(1) See Technical Data for maximum fuse size, Hardware manual
NOTE: XPSMC32 with 32 inputs i1...i32, otherwise identical

Enable switch contact:

An overview of the functions and their configurations is given in chapter Example Wiring and
Functional Diagrams, page 140.

Maximum Response Time
You can select the response time for the XPSMC••Z versions. For the XPSMC••X versions,
the response time is ≤ 20 ms. By selecting the response time, you can reduce the load of the
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CPU. Note that when you change the response time in a configuration, configurable timers
are set to zero and must be modified again. The limit ranges for the timers is also changed.

Creating an Application Configuration

Selecting a Controller Type and Communication Settings

Procedure
Proceed as follows:

Step Action

1 Start the XPSMCWIN configuration software.

2 Drag the symbol of the desired controller from the Device Library window into the
Configuration window. When you release the left mouse button, a new configuration is
automatically created.

3 The following Configuration dialog box appears:

NOTE: If the window does not open automatically, you are prompted to activate automatic
opening in the Options editor menu option.

Fill in the Configuration dialog box and click OK.
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Step Action

4
The following Controller dialog box appears:

Select the Response Time desired for the outputs.
NOTE: You can select the response time for the XPSMC••Z versions. For the XPSMC••X
versions, the response time is ≤ 20 ms.

5 Click on the relevant change... button to provide for adjustments for the Modbus and/or Profibus
communication.
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Step Action

6 Fill in the window which has opened.

The following figure shows the Modbus Parameters dialog box:

The following figure shows the Profibus Parameters dialog box:

If the PC is not connected to the XPSMC Safety Controller (Controller 1 in this example), the
Modbus settings cannot be sent at this point. The settings would then need to be sent to the
XPSMC Safety Controller once connected.

You can download only the communication settings (not the entire Application configuration) for
the Modbus and Profibus by clicking on the Download button when your PC is connected to the
XPSMC Safety Controller.

108 33003281.06



Configuration

Step Action

7 Click OK.

Result: Your screen should now look like the one in this figure:

Assigning the Selector Switch Position

Introduction
To continue with the configuration example, a selector switch needs to be configured, which
determines if the machine will be started with the safety guard OR with the enabling switch
(see the block diagram in the chapter Generals, page 104).
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To configure this OR connection, the symbol of the OR device has to be first moved to the
o1 output as follows:

Later, you will program the OR function block and assign its inputs.

Assigning the Protective Guard Function

Procedure
Proceed as follows:
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Step Action

1 In the Safety Guard folder (which is located in the Monitoring Devices folder), select the 2-
channel protection door symbol, and drag it onto the symbol of the OR component.

Result: A window opens, in which you have to define the function properties, for example:

2 Confirm with OK.

Result: The protection door device is then assigned with the OR component to safety-related
output o1.

Assigning the Starting Function

Procedure
Proceed as follows:
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Step Action

1 In the Start Devices folder, which is located in the Monitoring Devices folder, select the
Monitored Start device symbol and drag-and-drop it to the Safety Guard Device in the
configuration window.

Result: A dialog box for the definition of the function properties opens. The following figure
shows an example of the dialog box:

2 Confirm with OK.

Result: The Monitored Start Device is assigned to the Safety Guard device safety-related
output o1.

Assigning the Enabling Device

Introduction
According to this example application, the safety guard can be bypassed by the 3 channel
enabling device. This gives the possibility for the Robot to run with the safety guard open
when the 3 channel enabling device is used (when selector switch is in appropriate
position).
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Procedure
Proceed as follows:

Step Action

1
Drag the 3-channel enabling device symbol from the Enabling Devices folder onto the OR
Device symbol in the Configuration window and fill in the window.

2 Confirm with OK.

The following image shows the resulting configuration:
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EDM Adjustment

Introduction
The opening contacts of switches Ko1 and Ko2 must be defined with a synchronization time
of 0.2 s, i.e. within 0.2 s after the activation of safety-related outputs o1 and o2, and the
return circuit must be open.

Procedure
Proceed as follows:

Step Action

1
Drag the EDM symbol from the EDM Devices folder onto symbol o1 in the Configuration
window.

2 Confirm with OK.

The following image shows the resulting configuration:
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Assign a Name and a Stop Category to a Safety-Related
Output

Procedure
Proceed as follows:

Step Action

1 Click the right mouse button on its function symbol in the Configuration window to assign a
name and a stop category to safety-related output o1.

2
Select the Properties menu option. Indicate a name and the stop category.

3 Confirm with OK.

Result: This completes the configuration of safety-related output o1.

Copying the State of One Safety-Related Output onto
another Safety-Related Output

Description
In our example, o2 represents the 2nd channel of a safety-related control system, and must
consequently behave exactly like o1. Left-click o1 in the configuration window, then drag
and drop it onto o2.
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The global protection door function is then configured for safety-related outputs o1 and o2.

Your screen should look like the one below:

Configuring the Emergency Stop Function

Overview
This section contains the configuration description of the Emergency Stop function.

Emergency Stop

Description
In our example, the global control system of the machine must be able to be stopped by
means of Emergency Stop button S1 which activates free outputs 13 / 14 and 23 / 24 of
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relay group R1. Their contactors KE1 and KE2 are assigned to provide that, when the
machine is started, KE1 and KE2 are stopped in a statutory fashion.

Procedure
Proceed as follows:

Step Action

1 Drag the Two-Channel Emergency Stop symbol from the Emergency Stop folder (which is
located in the Monitoring Devices folder) onto the output symbol of R1 in the Configuration
window, and fill in the window.

2 Confirm with OK.

Result: Now the E-Stop device is assigned to the safety-related relays group R1.

3 To also assign the device to the solid state output o1, right-click on the E-Stop device in the
Configuration window. Choose Copy from the selection.

Result: The E-Stop device will then be copied with its properties.
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Step Action

4 Right-click on the symbol of the output o1. Select Paste and as copy of device.

Result: The E-Stop device will now also act on the output o1, and as the output state o1 is linked
with o2, it will also act on o2.

NOTE: To view the copies of a device, right click on the device. Mark e.g. E-Stop and select
the menu Mark Copies. On the copies a green bubble appears. To remove the bubbles click
Unmark Copies.
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Step Action

5 To adjust the return circuit, drag the EDM device symbol from the EDM Devices folder onto the
symbol for R1 in the Configuration window, fill in the dialog box in accordance with the
application.
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Step Action

6 Confirm with OK.

Result: This provides that the installation can only be started when KE1 and KE2 are closed and
the external start conditions (ESC) are fulfilled.

NOTE: If a control output c1...c8 has been used, a "*" follows the name, for example "c2*",
appears when this output is selected.

You must ensure that no hazardous situation can occur when this control output is used more
than once, because a cross-circuit, for example, is no longer detected (refer to the hazard
message hereafter).

Your screen should now look like the one below:

7 Complete the creation of the example configuration by saving and download it to the XPSMC
Safety Controller.

WARNING
LOSS OF CROSS-CIRCUIT DETECTION
• Ensure that the required safety level of the application is not compromised by using the

same control output for different devices.
• Carefully analyze and understand how the circuits which are sharing control outputs

interact in your application.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.
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Master E-Stop Device

Description
An E-Stop device acts as a Master E-Stop on the other devices of the output. The other
devices will be deactivated when the Master E-Stop is pressed. When this occurs, the start
of this output is not possible until the start conditions of the other devices are met.

This is also available for the copies of the E-Stop devices.
NOTE: An Output State does not transfer a master E-Stop command on other devices.

Save the Configuration

Overview
This section contains the description to save the configuration.

Save

Description
The configuration can be saved by using the File > Save menu option (or by clicking on the

floppy disk symbol button ) or by using the File > Save As... option and assigning a
new path/name.

NOTE: When you close the configuration file and then open it again, a back-up copy is
created in the same directory, with a .mcb extension. This way your last saved and
closed configuration is stored as a back-up file.

Requesting/Changing the Password

Overview
This section contains the description of entering and changing the password.
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Password

Enter Password
NOTE: Your PC must be connected to the XPSMC Safety Controller.

Each XPSMC Safety Controller command involving quitting the RUN mode (setting up the
XPSMC Safety Controller for example) must be confirmed with a password. If such a
command is performed, a dialog box opens in which the password must be entered.

Change Password
The default password is safety; it must be modified upon first use. The password must
contain between 4 and 12 characters. Use a combination of letters and numbers.

The password can be modified with command Controller > Change password.
NOTE: The password is case sensitive.

Sending a Configuration from the PC to the
XPSMC Safety Controller and Performing a
Verification

Overview
This section contains the description of sending a configuration.

Sending a Configuration

Procedure
To send a completed configuration from the PC to the XPSMC Safety Controller, follow this
procedure:
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Step Action

1 Select Check > Check Configuration to verify the configuration.

You can click on the Check Configuration icon alternatively:

Result: If the configuration contains no errors, the following message box appears:

If the configuration contains errors, a yellow question mark will be seen, and a corresponding
message box will appear.

NOTE: The configuration will be verified for consistency. This neither verifies the functional
safety nor the suitability of the configuration for your application. You are responsible to
ensure this and to comply with all applicable codes and standards.

WARNING
UNINTENDED EQUIPMENT OPERATION
• You must carry out a risk assessment in accordance with ISO 12100.
• Validate the entire system/machine in accordance with the required

performance level and risk assessment.
Failure to follow these instructions can result in death, serious injury,
or equipment damage.
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Step Action

2
Go to Controller > Download Configuration to Controller to download the configuration:

You can click on the Configuration icon alternatively:
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Step Action

3
Click on the Download button.

Result: If the controller already has a configuration, the following message will appear:

4 Click Yes to continue the procedure.

Result: If the controller is in RUN, the following message will appear:
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Step Action

5 Click Yes to continue the procedure.

Result: To stop the controller, enter your password. For more information, refer to Passwords,
page 122.

6 Click OK to continue.

Result: The download procedure is starting.

After the download, you will see the protocol:

NOTE: Read this protocol carefully and verify it with your hardware configuration. With
Validate you confirm the correctness of the software configuration in the controller shown in
the protocol.

7 Click on Validate button to validate the protocol.
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Step Action

8
Enter the name in the Validation dialog box:

9 Click OK to continue.

Result:

The Password dialog box will be displayed:

10 Enter your password and click OK.

11 Click OK to continue.

Result: The following message will be displayed:
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Step Action

12 Click Yes to upload the protocol.

Result: The following message will be displayed:

13 Click OK to start the controller.

Result: The following message will be displayed

14 Click OK to finish the procedure.
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Typical Configuration Errors
Configuration error 1: If no start device is assigned to the Two-Channel Safety Guard, the
main window and the message box will look as follows:
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Configuration error 2: If the inputs and outputs of the start device are not set, the main
window and the message box will look as follows:

Loading a Configuration

Overview
This section contains the description of loading a configuration.

Loading

Description
The configuration of a controller can be uploaded without stopping the controller.
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Procedure
Proceed as follows:

Step Action

1 Connect your PC to the XPSMC Safety Controller.

2 Choose the command Controller > Upload Configuration from Controller or click on the

button in the toolbar.

Result: The configuration is loaded from the XPSMC Safety Controller and then represented in
the usual tree structure.

Creation/Transfer of a Validated Configuration
Copy

Overview
This section contains the description of creation and transfer a validated configuration copy.

Copy/Saving of a Validated Configuration

Condition
As a condition to create a copy of a validated configuration, the Enable copying of
validated configuration from controller option must be selected during the validation of
the configuration, see also Sending a Configuration, page 122, step for the validation. Under
this condition the user is able to make a copy of the validated configuration from the XPSMC
Safety Controller into a binary file. In addition, the Create a copy of the validated
configuration now option can be selected in order to create a copy during the validation.

Copy of a Validated Configuration
Included with the configuration itself, the following data of the original controller is taken:

• validation counter (VDC)
• password
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• validation data (name, date)
• device parameters (Modbus parameters, controller number)

This file can be used as a copy to transfer the validated configuration to another controller
without the need of a new validation.

Saving a Validated Configuration
Proceed as follows:

Step Action

1 Connect the PC to the controller containing the validated configuration.

2 Choose the command Controller > Create validated copy.

Result: The configuration will be read out of the controller.

3 Enter the save location and file name in the window which appears.

Result: The copy will be saved as this file.

Transfer of a Validated Configuration Copy

Description
When a file with a copy of a validated configuration has been made (see chapter Copy/
Saving of a Validated Configuration, page 131) for a certain controller, you can transfer the
configuration into another controller, especially for replacement of a XPSMC Safety
Controller unit for service or for installation of controllers in identical machines.

Procedure 1 - New Controller
Proceed as follows:
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Step Action

1 Connect the PC to the controller in which the validated configuration is to be transferred.

Result: The controller is not configured, the Power LED is on, and the CNF LED is flashing.

2 Choose the command Controller > Validated copy > Transfer validated copy to controller.

Result: You get 2 messages:
• Please connect the controller you want the configuration to transfer to and press ’OK’ to

start the transfer.
• Transferring the copy will overwrite the existing configuration in the controller. Do you want

to continue?

3 Indicate in the dialog box the name of the validated configuration file.

Result: The validated configuration is transferred into the connected controller.

A message box tells you to powercycle the controller to start the new configuration.

Procedure 2 -Configured Controller, Password Available
Proceed as follows:

Step Action

1 Connect the PC to the controller in which the validated configuration is to be transferred.

2 Choose the command Validated copy > Transfer validated copy to controller.
NOTE: If the controller is running, another message box reminds you that the controller has
to be stopped. You will also be reminded to enter your password. If you do not have a
password, you will have to reset the controller by powercycling it and simultaneously
pressing the Reset button. See also Procedure 1 - New Controller, page 132 for
downloading a validated copy.

3 Indicate in the dialog box the name of the file.

Result: The validated configuration is transferred into the connected controller.

A message box tells you that you have to powercycle the controller to start the new configuration
and run the controller.

NOTE: To modify the configuration, you need the password of the validated
configuration. The controller password has been overwritten.
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Procedure 3 - Configured Controller, Password Unavailable
Reset the controller by pressing the Reset button and simultaneously performing a power
cycle. Then follow Procedure 1 - New Controller, page 132.

Validated Configuration into another Controller
The new controller now has the validated configuration, including the validation counter
(VDC), the password, the validation data (name, date) and the device parameters (Modbus
parameters, controller number).

It can be used like the original controller from which the copy was made from, except that
the running time (OPC) of the configuration is set to zero.

Read Protocol from Controller

Overview
This section contains how to read the protocol from the controller.

Read Protocol from Controller

Procedure
Proceed as follows:

Step Action

1 Connect the PC to the XPSMC Safety Controller.

2 The controller has to be put in STOP with the menu Controller > Stop Controller.

3 A window appears, and you are asked to enter your password to stop the controller.

4 Choose the menu Controller > Read Protocol from Controller.

Result: The protocol will be displayed in a separate window and can be printed.

The only proof of the correctness of the configuration is the validated and signed protocol (See
chapter Sending a Configuration, page 122).
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Diagnostics
Overview

This chapter contains the diagnostics description.

XPSMC Safety Controller Diagnostics

Introduction
Various states of an XPSMC Safety Controller can be monitored by connecting it to a PC
and using the diagnostics mode of the XPSMCWIN application.

NOTE: During the diagnostics, the XPSMC Safety Controller continues to operate
without being influenced.

Procedure
The Diagnostic mode is activated as follows:

Step Action

1 Connect your PC to the XPSMC Safety Controller in operation.

2 Start the XPSMCWIN software.

3 Open a configuration from a file or upload the configuration from the controller.
NOTE: The saved configuration must correspond to the one already in the controller. The
controller configuration must have been validated. To use a saved configuration for
diagnostics it has to be saved after download. Only in this case it contains the required
information.

4 Choose the Diagnostic mode. To do this, choose the menu Mode > Diagnostic or click on the

icon for the Diagnostic mode.

Result: The window will become grey, to show that no modifications can be made.
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Color Definitions
In the Configuration window, a colored circle is placed next to each function symbol of the
configuration tree.

The color indicates the status of the corresponding function:

Meaning of symbols

Symbols Meaning

Red Dot The safety-related output is deactivated or the device is not enabled (for
example, protective guard is open or the concerned input is open).

Red Dot with a Yellow bolt An error exists for this device (input/output). The error message is shown
at the bottom of the configuration window.

Green Dot The safety-related output is activated, or the device is enabled (for
example, protective guard is closed or the concerned input is closed).
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Symbols Meaning

Green Dot with a Hourglass This output has a category 1 stop.

The enabling conditions are no longer fulfilled, but the time delay has not
elapsed.

Yellow Dot This device or this output is enabled (this means that the conditions to
start are fulfilled), but not started.

Grey Dot The related output or device is not used, or the PC has not received the
diagnostics data from the XPSMC Safety Controller (the points are then
disabled).

Diagnostics of Different Devices
Proceed as follows

Step Action

1 Right-click the device to see the state of the inputs of the different devices

2 Right-click within the Diagnostic window.

Result: A contextual menu will appear.

3 Select Overview from the menu.

Result: A new window appears displaying the diagnostics of the inputs and outputs of the
controller.

4 Click on Pause diagnostic in the menu Diagnostics to pause the diagnostics.

Result: The Diagnostic window keeps the status.

5 Click on Start diagnostic in the menu Diagnostics to start the diagnostics.

Result: The window will be continuously updated.

33003281.06 137





Appendices
What’s in This Part

Example Wiring and Functional Diagrams................................ 140

Overview
Additional information that is not necessarily required for an understanding of the
documentation.

33003281.06 139



Example Wiring and Functional Diagrams

Example Wiring and Functional Diagrams
What’s in This Chapter

Three One-Channel Emergency Stops, with Automatic
Start...................................................................................... 141
Two Two-Channel Emergency Stop, with Start Button............... 143
Safety Guard with One Channel .............................................. 145
Two-Channel Safety Guard..................................................... 148
Two Channels Safety Guard with Lock..................................... 154
Light Curtain with Relay Outputs ............................................. 158
Light Curtain with Transistor Outputs ....................................... 164
Muting for Light Curtains Type 4.............................................. 170
Magnetic Switch .................................................................... 172
Two-Hand Control .................................................................. 176
Safety Mat............................................................................. 178
Zero Speed Detection ............................................................ 180
Injection Molding Machines..................................................... 183
Hydraulic Press Valve Monitoring ............................................ 187
Hydraulic Press 2................................................................... 189
Eccentric Press...................................................................... 195
Eccentric Press 2................................................................... 200
Selector Switch...................................................................... 206
Timer .................................................................................... 208
Shaft/Chain-Break Monitoring ................................................. 211
Seat Valve Monitoring ............................................................ 213
Enabling Device 2 Channel..................................................... 215
Enabling Device 3 Channel..................................................... 217
Foot Switch ........................................................................... 219

Overview
This chapter contains examples of wiring and functional diagrams.

NOTE: The data for safety categories in accordance with ISO 13849-1 refers to the
maximum achievable categories. The machine control must be appropriately configured
in order to achieve the desired category.
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Three One-Channel Emergency Stops, with
Automatic Start

Functional Diagram
The following diagram shows three One-Channel Emergency Stops and the relevant control
outputs for categories 0 and 1:
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Wiring Diagram
The following image shows the wiring diagram of the One-Channel Emergency Stop:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.
NOTE: A jumper between the 2 terminals of an Emergency Stop will not be detected.
Cross-circuit between i1, i2, i3 will be detected.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Two Two-Channel Emergency Stop, with Start
Button

Functional Diagram
The following functional diagram shows two Two-Channel Emergency Stops and the
relevant control outputs for Categories 0 and 1:
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Wiring Diagram
The following wiring diagram shows two Two-Channel Emergency Stops and the relevant control
outputs for the Categories 0 and 1:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Wiring Diagram with Externally Supplied 24 V Input
The following wiring diagram shows two Two-Channel Emergency Stops and the relevant
control outputs for the Categories 0 and 1 with externally supplied 24 V input:

NOTE: For safety-related inputs not supplied by control outputs use external means to
achieve up to SIL3 (IEC 62061) or PL e, Category 4 (ISO 13849-1), e.g. shielded cable.

Safety Guard with One Channel

Functional Diagram
The following functional diagram shows the Safety Guard with One Channel with Start
Interlock and different Start Functions:
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Start Function Start Interlock = YES

Automatic Start

Monitored Start

Rising Edge

Monitored Start

Falling Edge

The following functional diagram shows the Safety Guard with One Channel without Start
Interlock and different Start Functions:
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Start Function Start Interlock = NO

Automatic Start

Monitored Start

Rising Edge

Monitored Start

Falling Edge
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Wiring Diagram
The following wiring diagram shows the Safety Guard with One Channel with and without Start
Interlock and different Start Functions:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.

Two-Channel Safety Guard

Functional Diagram
The following functional diagram shows the Two-Channel Safety Guard with Start Interlock
and different Start Functions:
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Start Function Start Interlock = YES

Automatic Start

Monitored Start

Rising Edge
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Start Function Start Interlock = YES

Monitored Start

Falling Edge

The following functional diagram shows the Two-Channel Safety Guard without Start
Interlock and different Start Functions:
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Start Function Start Interlock = NO

Automatic Start

Monitored Start

Rising Edge
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Start Function Start Interlock = NO

Monitored Start

Falling Edge
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Wiring Diagram
The following wiring diagram shows the Two-Channel Safety Guard with and without Start Interlock
and different Start Functions:

ESC External Start Conditions

EDM External Device Monitoring

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse size

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Two Channels Safety Guard with Lock

Functional Diagram
The following functional diagram shows the Two-Channel Safety Guard with Lock and with
Start Interlock and different Start Functions:
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Start Function Start Interlock = YES

Automatic Start

Monitored Start

Rising Edge

Monitored Start

Falling Edge

The following functional diagram shows the Two-Channel Safety Guard with Lock and
without Start Interlock and different Start Functions:
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Start Function Start Interlock = NO

Automatic Start

Monitored Start

Rising Edge

Monitored Start

Falling Edge
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Wiring Diagram
The following wiring diagram shows the Two-Channel Safety Guard with Lock and with and without
Start Interlock and different Start Functions:

ESC External Start Conditions

EDM External Device Monitoring

(1) See Technical Data in XPSMC Safety Controller Hardware manual form maximum fuse size

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Light Curtain with Relay Outputs

Functional Diagram
The following functional diagram shows the Light Curtain with Relay Outputs with Start
Interlock and different Start Functions:
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Start Function Start Interlock = YES

Automatic Start

Monitored Start

Rising Edge

Input OSSD1

Input monitored 
start

Light curtain
free

Light curtain 
freeRi

sin
g

Input OSSD2

Input EDM

t < t syn.

Light curtain inter-
rupted

t < tEMD 
no start

Output

OSSD: Output Safety Switching Device
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Start Function Start Interlock = YES

Monitored Start

Falling Edge

The following functional diagram shows the Light Curtain with Relay Outputs without Start
Interlock and different Start Functions:
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Start Function Start Interlock = NO

Automatic Start

Monitored Start

Rising Edge

Input OSSD1

Input monitored 
start

Light curtain
free

Light curtain 
freeRi

sin
g

Input OSSD2

Input EDM

t < t syn.

Light curtain inter-
rupted

t < tEMD 
no start

Output

OSSD: Output Safety Switching Device
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Start Function Start Interlock = NO

Monitored Start

Falling Edge
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Wiring Diagram
The following wiring diagram shows the Light Curtain with Relay Outputs with and without Start
Interlock and different Start Functions:

ESC External Start Conditions

EDM External Device Monitoring

ESPE Electro Sensitive Protective Equipment

OSSD Output Safety Switching Device

(1) See Technical Data in XPSMC Safety Controller Hardware manual form maximum fuse size

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Light Curtain with Transistor Outputs

Functional Diagram
The following functional diagram shows the Light Curtain with Transistor Outputs with Start
Interlock and different Start Functions:

164 33003281.06



Example Wiring and Functional Diagrams

Start Function Start Interlock = YES

Automatic Start

Monitored Start

Rising Edge
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Start Function Start Interlock = YES

Monitored Start

Falling Edge

The following functional diagram shows the Light Curtain with Transistor Outputs without
Start Interlock and different Start Functions:
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Start Function Start Interlock = NO

Automatic Start

Monitored Start

Rising Edge
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Start Function Start Interlock = NO

Monitored Start

Falling Edge
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Wiring Diagram
The following wiring diagram shows the Light Curtain with Transistor Outputs with and without
Start Interlock and different Start Functions.

ESC External Start Conditions

EDM External Device Monitoring

ESPE Electro Sensitive Protective Equipment

OSSD Output Safety Switching Device

(1) See Technical Data in XPSMC Safety Controller Hardware manual form maximum fuse size

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Muting for Light Curtains Type 4

Functional Diagram
The following functional diagram shows the Muting for light curtains type 4:
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Wiring Diagram
The following wiring diagram shows the Muting for light curtains type 4:

ESC External Start Conditions

EDM External Device Monitoring

ESPE Electro Sensitive Protective Equipment

(1) See Technical Data in XPSMC Safety Controller Hardware manual form maximum fuse size

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Magnetic Switch

Functional Diagram
The following functional diagram shows the Magnetic Switch with Interlock and different
Start Functions:
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Start Function Start Interlock = YES

Automatic Start

Monitored Start

Rising Edge

Monitored Start

Falling Edge

The following functional diagram shows the Magnetic Switch without Interlock and different
Start Functions:
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Start Function Start Interlock = NO

Automatic Start

Monitored Start

Rising Edge

Monitored Start

Falling Edge
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Wiring Diagram
The following wiring diagram shows the Magnetic Switch with and without Interlock and different
Start Functions

ESC External Start Conditions

EDM External Device Monitoring

(1) See Technical Data in XPSMC Safety Controller Hardware manual form maximum fuse size

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Two-Hand Control

Functional Diagram
The following functional diagram shows the Two-Hand Control device:
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Wiring Diagram
The following wiring diagram shows the Two-Hand Control device:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Safety Mat

Functional Diagram
The following functional diagram shows the Safety Mat:
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Wiring Diagram
The following wiring diagram shows the Safety Mat:

ESC External Start Conditions

EDM External Device Monitoring

(1) See Technical Data in XPSMC Safety Controller Hardware manual form maximum fuse size

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Zero Speed Detection

Functional Diagram
The following functional diagram shows the Zero Speed Detection:

Input i1
Sensor 1

Input i2
Sensor 2

Output

f1,f2  < f Max. f1, f2 > f Max. f1, f2 < f Max.

Sensor control: Sensor 1

Sensor 2

NOTE: Use inputs i1 and i2 for zero speed detection. The two sensors must be arranged
so that only one sensor is activated at any given time. If the inputs are in the low state,
the zero speed signal will disappear after t=1/f and an open-circuit will be indicated. If
the 2 inputs are in the high state, the zero speed signal will disappear after t=1/f and a
cross-circuit will be indicated. If the 2 inputs are in the high or low state after starting, no
enabling will take place.
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Wiring Diagram
The following wiring diagram shows the Zero Speed Detection:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.

Operating Conditions
Observe the following points for the operation of the zero speed detection:

• The sensors must be arranged so that only 1 sensor is activated at any given time (=
HIGH-Signal).

• If both sensors are in the LOW state, a cable break error message is indicated and the
corresponding outputs are deactivated.
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• If both sensors are in the HIGH state after power on of the XPSMC Safety Controller, a
notification is available via Modbus RTU, or via the configuration terminal (PC), and the
corresponding outputs are deactivated. After a zero speed detection followed by
subsequent motion the notification is reset.

• If zero speed is already detected and both sensors are in HIGH state, a notification is
available via Modbus RTU, or via the configuration terminal (PC), and the
corresponding outputs are activated.

• If only 1 sensor produces a dynamic signal after a zero speed, an error message
appears after 30 s and the corresponding outputs are deactivated.

• If, after the XPSMC Safety Controller has started, both sensors are in the LOW state,
an error message is available via the Error LED on the XPSMC Safety Controller and
Modbus RTU, or via the configuration terminal (PC).
NOTE: You can only use one Zero Speed Detection per XPSMC Safety Controller,
because there are only two counter inputs (i1and i2) per controller. For the same reason
you cannot use the Zero Speed Detection device simultaneously with the Shaft/Chain
Break Monitoring device on the same XPSMC Safety Controller.
NOTE: The output will be activated if the sensors detect no motion.

Sensor States and Behavior
Switch-on Sequence

State of Sensor 1 0 0 (*) 1

State of Sensor 2 0 1 (*) 1

Behavior Error Message Zero Speed Notification (**)

Output 0 1 0

Operation

State of Sensor 1 0 0 (*) 1

State of Sensor 2 0 1 (*) 1

Behavior Error Message Zero Speed Notification

Output 0 1 1
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* If the state of the sensors is inverse (0/1, 1/0), the behavior is identical.

** If the firmware version is earlier than 2.34 an error message (cross circuit between
inputs) appears instead of a notification. This error message must be
acknowledged with the reset button.

NOTE: When XPSMC••Z•• with firmware version earlier than 2.35 starts its
function with both sensor inputs at HIGH, then the cross circuit between inputs
stays ON.

Error Message External error messages must be acknowledged with the reset button.

Notification A notification, sent via Modbus, does not need to be acknowledged. As soon as the
sensor states change, it will be acknowledged automatically.

Injection Molding Machines

Functional Diagram
The following functional diagram shows the Safety Guard with One Channel with Start
Interlock and different Start Functions:
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Start Function Start Interlock = NO

Automatic Start

Monitored Start

Rising Edge
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Start Function Start Interlock = NO

Monitored Start

Falling Edge
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Wiring Diagram
The following wiring diagram shows the Injection Molding with Start Functions:

EDM External Device Monitoring

ESC External Start Conditions

(1) See Technical Data in XPSMC Safety ControllerHardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Hydraulic Press Valve Monitoring

Functional Diagram
The following functional diagram shows the Hydraulic Press Valve Monitoring:
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Wiring Diagram
The following wiring diagram shows the Hydraulic Press Valve Monitoring:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Hydraulic Press 2

Functional Diagrams
The following functional diagram shows the Hydraulic Press 2, Mode = INCHING
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The following functional diagram shows the Hydraulic Press 2, Mode = SINGLE STROKE,
with overtravel monitoring and Open + Close command from the non-safety-related
controller:
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The following functional diagram shows the Hydraulic Press 2, Mode = SINGLE STROKE:
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The following functional diagram shows the Hydraulic Press 2, Mode = Automatic, with
overtravel monitoring and Open + Close command from the non-safety-related controller:
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The following functional diagram shows the Hydraulic Press 2, Mode = AUTOMATIC,
without OT + UT signals:
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Wiring Diagram
The following wiring diagram shows the Hydraulic Press 2:
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Eccentric Press

Functional Diagrams
The following functional diagram shows the Eccentric Press, Mode = SINGLE STROKE
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Example Wiring and Functional Diagrams

The following functional diagram shows the Eccentric Press, Mode = INCHING
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Example Wiring and Functional Diagrams

The following functional diagram shows the Eccentric press, Mode = CONTINUOUS
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Example Wiring and Functional Diagrams

Wiring Diagram

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
• Disconnect all power from all equipment including connected devices prior to removing

any covers or doors, or installing or removing any accessories, hardware, cables, or
wires except under the specific conditions specified in the appropriate hardware guide
for this equipment.

• Always use a properly rated voltage sensing device to confirm the power is off where
and when indicated.

• Replace and secure all covers, accessories, hardware, cables, and wires and confirm
that a proper ground connection exists before applying power to the unit.

• Use only the specified voltage when operating this equipment and any associated
products.

Failure to follow these instructions will result in death or serious injury.
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Example Wiring and Functional Diagrams

The following wiring diagram shows the Eccentric Press:

OTS Top Dead Center

PSV Press Safety Valve

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Example Wiring and Functional Diagrams

Eccentric Press 2

Functional Diagram
The following functional diagram shows the Eccentric Press 2, Mode = INCHING:
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Example Wiring and Functional Diagrams

The following functional diagram shows the Eccentric Press 2, Mode = SINGLE STROKE:
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Example Wiring and Functional Diagrams

The following functional diagram shows the Eccentric Press 2, Mode = CONTINUOUS:
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Example Wiring and Functional Diagrams

The following functional diagram shows the Eccentric Press 2, Mode = CONTINUOUS
AUTOMATIC:
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Example Wiring and Functional Diagrams

Wiring Diagram

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
• Disconnect all power from all equipment including connected devices prior to removing

any covers or doors, or installing or removing any accessories, hardware, cables, or
wires except under the specific conditions specified in the appropriate hardware guide
for this equipment.

• Always use a properly rated voltage sensing device to confirm the power is off where
and when indicated.

• Replace and secure all covers, accessories, hardware, cables, and wires and confirm
that a proper ground connection exists before applying power to the unit.

• Use only the specified voltage when operating this equipment and any associated
products.

Failure to follow these instructions will result in death or serious injury.
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Example Wiring and Functional Diagrams

The following image shows the wiring diagram of the Eccentric Press 2 device:

OTS Top Dead Center

PSV Press Safety Valve
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Example Wiring and Functional Diagrams

Selector Switch

Functional Diagram
The following image represents the functional diagram of the Selector Switch device:

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Example Wiring and Functional Diagrams

Wiring Diagram
The following image represents the wiring diagram of the Selector Switch device:
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Example Wiring and Functional Diagrams

Timer

Functional Diagram
The following image represents the functional diagram of the Timer device for the On-/Off-
Delay:

208 33003281.06



Example Wiring and Functional Diagrams

The following image represents the functional diagram of the Timer device for the On-/Off
Pulse:
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Example Wiring and Functional Diagrams

Wiring Diagram
The following image represents the wiring diagram of the Timer device:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Example Wiring and Functional Diagrams

Shaft/Chain-Break Monitoring

GBS Function Diagram
The following diagram shows the GBS function of the Shaft/Break-Chain Monitoring device:

Sensor Position
The following diagram shows the Shaft/Chain-Break Monitoring function when the sensor is
high or low at standstill:
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Example Wiring and Functional Diagrams

Wiring Diagram
The following image is the Shaft/Chain-Break Monitoring wiring diagram:

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Example Wiring and Functional Diagrams

Seat Valve Monitoring

Functional Diagram
The following image represents the functional diagram of the Seat Valve Monitoring device:
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Example Wiring and Functional Diagrams

Wiring Diagram
The following image represents the wiring diagram of the Seat Valve Monitoring device:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Example Wiring and Functional Diagrams

Enabling Device 2 Channel

Functional Diagram
The following diagram represents the functional diagram of the Enabling Device 2 Channel:
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Example Wiring and Functional Diagrams

Wiring Diagram
The following diagram represents the wiring diagram of the Enabling Device 2 Channel:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.

NOTE: The XPSMC32 safety controller with 32 inputs is identical in function and wiring,
but to inputs i1 to i32.
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Example Wiring and Functional Diagrams

Enabling Device 3 Channel

Functional Diagram
The following diagram represents the functional diagram of the 3-contact Enable Switch:
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Example Wiring and Functional Diagrams

Wiring Diagram
The following diagram represents the wiring diaram of the 3-contact Enable Switch:

(1) See Technical Data in XPSMC Safety Controller Hardware manual for maximum fuse sizes.

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.

NOTE: The XPSMC32 safety controller with 32 inputs is identical in function and wiring,
but to inputs i1 to i32.
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Example Wiring and Functional Diagrams

Foot Switch

Functional Diagram
The following images represents the Foot Switch functional diagram:

The static outputs are rated PL e, category 4 according to ISO 13849-1, up to SIL 3
according to IEC 62061.
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Example Wiring and Functional Diagrams

Wiring Diagram
The following image represents the Foot Switch wiring diagram:
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Example Wiring and Functional Diagrams

Wiring Diagram with Externally Supplied 24 V Input
The following wiring diagram shows the Foot Switch with externally supplied 24 V input:

NOTE: For safety-related inputs not supplied by control outputs use external means to
achieve up to SIL3 (IEC 62601) or PL e, Category 4 (ISO 13849-1), e.g. shielded cable.
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Glossary
E
EDM:

external device monitoring

ESC:

external start conditions

ESPE:

electro sensible protective equipment

O
OSSD:

output safety switching device

OTS:

top dead center (Oberer Totpunktschalter)

P
PDO:

(process data object) An unconfirmed broadcast message or sent from a producer device
to a consumer device in a CAN-based network. The transmit PDO from the producer
device has a specific identifier that corresponds to the receive PDO of the consumer
devices.

R
RUN Mode:

XPSMC Safety Controller functional status during which the connected circuit members are
monitored and the safety outputs are switched.
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S
Safety-Related Input:

Monitored input for connection of switching devices. By using various control outputs (c1...
c8) to power the safety-related inputs, cross-connections, external voltage and ground
connections can be detected on the safety-related inputs.

safety-related Outputs:

Relay or solid-state output activated by the XPSMC Safety Controller logic unit, which are
able to cut off the subordinate control elements.

Synchronization Time:

maximum time difference allowed between the appearance of 2 input signals

T
TER (Connector for Terminal):

8 pin RJ45 connector for the connections of a PC for the configuration or diagnostic (bus
system with Modbus protocol) or connections of another Modbus module (non-safety-
related controller, terminals, etc...).

V
VDC:

validation counter
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